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consequential damages or any damages whatsoever including but not limited to damages resulting from loss
of use, data, profits, revenues, or customers, arising out of or in connection with the use or performance of
information contained in this document.

Gemalto does not and shall not warrant that this product will be resistant to all possible attacks and shall not
incur, and disclaims, any liability in this respect. Even if each product is compliant with current security
standards in force on the date of their design, security mechanisms' resistance necessarily evolves according
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systems or equipment incorporating Gemalto products. Gemalto disclaims any liability with respect to security
for direct, indirect, incidental or consequential damages that result from any use of its products. It is further
stressed that independent testing and verification by the person using the product is particularly encouraged,
especially in any application in which defective, incorrect or insecure functioning could result in damage to
persons or property, denial of service, or loss of privacy.

Allintellectual property is protected by copyright. All trademarks and product names used or referred to are the
copyright of their respective owners. No part of this document may be reproduced, stored in a retrieval system
or transmitted in any form or by any means, electronic, mechanical, chemical, photocopy, recording or
otherwise without the prior written permission of Gemalto.
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PREFACE:
About the SafeNet ProtectToolkit-M User
Guide

J

This document provides instructions on installation, configuration, administration, and troubleshooting for the
SafeNet ProtectToolkit-M suite of applications. It contains the following chapters:

vV V VvV vV VvV V VvV V V

vV V VvV VvV V

"Overview" on page 12

"Installation" on page 15

"Setup and Configuration" on page 17
"Administrative Tasks" on page 34

"User Tasks" on page 45

"Administration and User Utilities" on page 49
“Integration with Microsoft CA" on page 70
"Known Issues" on page 84

"Objects, as described by PKCS #11, consist of a number of attributes that define both the object and its
access policy. In general, the SafeNet ProtectToolkit-C system will define the object’s attributes. Access
policy should be provided by the user based on their particular requirements. The following attribute
descriptions are intended to assist with these decisions." on page 93

“Integration With 11S" on page 87
"Work Load Distribution" on page 95
"Registry Configuration" on page 96
"Event Log Error Types" on page 100
"Glossary" on page 104

This preface also includes the following information about this document:

vV V VvV VvV V

"Customer Release Notes" on the next page
"Gemalto Rebranding" on the next page
"Audience" on the next page

"Document Conventions" on page 9

"Support Contacts" on page 11

For information regarding the document status and revision history, see "Document Information” on page 2.
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Preface: Aboutthe SafeNet ProtectToolkit-M User Guide

Customer Release Notes

The customer release notes (CRN) provide important information about this release that is not included in the
customer documentation. It is strongly recommended that you read the CRN to fully understand the
capabilities, limitations, and known issues for this release. You can view or download the latest version of the
CRN for this release at the following location:

Gemalto Rebranding

In early 2015, Gemalto completed its acquisition of SafeNet, Inc. As part of the process of rationalizing the
product portfolios between the two organizations, the SafeNet name has been retained. As a result, the
product names for SafeNet HSMs have changed as follows:

Old product name New product name

ProtectServer External 2 (PSE2) SafeNet ProtectServer Network HSM
ProtectServer Internal Express 2 (PSI-E2) SafeNet ProtectServer PCle HSM
ProtectServer HSM Access Provider SafeNet ProtectServer HSM Access Provider
ProtectToolkit C (PTK-C) SafeNet ProtectToolkit-C

ProtectToolkit J (PTK-J) SafeNet ProtectToolkit-J

ProtectToolkit M (PTK-M) SafeNet ProtectToolkit-M

ProtectToolkit FM SDK SafeNet ProtectToolkit FM SDK

NOTE These branding changes apply to the documentation only. The SafeNet HSM
software and utilities continue to use the old names.

Audience

This document is intended for personnel responsible for maintaining your organization's security
infrastructure. This includes SafeNet ProtectToolkit users and security officers, key manager administrators,
and network administrators.

All products manufactured and distributed by Gemalto are designed to be installed, operated, and maintained
by personnel who have the knowledge, training, and qualifications required to safely perform the tasks
assigned to them. The information, processes, and procedures contained in this document are intended for
use by trained and qualified personnel only.

Itis assumed that the users of this document are proficient with security concepts.
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Preface: Aboutthe SafeNet ProtectToolkit-M User Guide

Document Conventions

This document uses standard conventions for describing the user interface and for alerting you to important
information.

Notes
Notes are used to alert you to important or helpful information. They use the following format:

I NOTE Take note. Contains important or helpful information.

Cautions

Cautions are used to alert you to important information that may help prevent unexpected results or data loss.
They use the following format:

Exercise caution. Contains important information that may help prevent
unexpected results or data loss.

Warnings

Warnings are used to alert you to the potential for catastrophic data loss or personal injury. They use the
following format:

*WARNING** Be extremely careful and obey all safety and security measures. In
this situation you might do something that could result in catastrophic data loss or
personal injury.

Command Syntax and Typeface Conventions

Format Convention
bold The bold attribute is used to indicate the following:
> Command-line commands and options (Type dir /p.)
> Button names (Click Save As.)
> Check box and radio button names (Select the Print Duplex check box.)
> Dialog box titles (On the Protect Document dialog box, click Yes.)
> Field names (User Name: Enter the name of the user.)
> Menu names (On the File menu, click Save.) (Click Menu > Go To > Folders.)
> Userinput (In the Date box, type April 1.)

italics In type, the italic attribute is used for emphasis or to indicate a related document. (See the
Installation Guide for more information.)
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Preface: Aboutthe SafeNet ProtectToolkit-M User Guide

Format Convention

<variable> In command descriptions, angle brackets represent variables. You must substitute a value for
command line arguments that are enclosed in angle brackets.

[optional] Represent optional keywords or <variables> in a command line description. Optionally enter the

[<optional>] keyword or <variable> that is enclosed in square brackets, if it is necessary or desirable to
complete the task.

{alb|c} Represent required alternate keywords or <variables> in a command line description. You must

{<a>|<b>|<c>} choose one command line argument enclosed within the braces. Choices are separated by vertical
(OR) bars.

[alb|c] Represent optional alternate keywords or variables in a command line description. Choose one

[<a>|<b>|<c>] command line argument enclosed within the braces, if desired. Choices are separated by vertical
(OR) bars.

SafeNet ProtectToolkit 5.5 User Guide
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Preface: Aboutthe SafeNet ProtectToolkit-M User Guide

Support Contacts

If you encounter a problem while installing, registering, or operating this product, please refer to the
documentation before contacting support. If you cannot resolve the issue, contact your supplier or

Gemalto Customer Support operates 24 hours a day, 7 days a week. Your level of access to this service is
governed by the support plan arrangements made between Gemalto and your organization. Please consult
this support plan for further information about your entitlements, including the hours when telephone support is
available to you.

Customer Support Portal

The Customer Support Portal, at is where you can find solutions for most
common problems. The Customer Support Portal is a comprehensive, fully searchable database of support
resources, including software and firmware downloads, release notes listing known problems and
workarounds, a knowledge base, FAQs, product documentation, technical notes, and more. You can also use
the portal to create and manage support cases.

NOTE You require an account to access the Customer Support Portal. To create a new
account, go to the portal and click on the REGISTER link.

Telephone Support
If you have an urgent problem, or cannot access the Customer Support Portal, you can contact Gemalto
Customer Support by telephone. Calls to Gemalto Customer Support are handled on a priority basis.

Region Telephone number

(Subject to change. An up-to-date list is maintained on the Customer Support Portal)
Global +1410-931-7520

Australia 1800.020.183

China North: 10800-713-1971
South: 10800-1301-932

France 0800-912-857

Germany 0800-181-6374

India 000.800.100.4290

Israel 180-931-5798

Italy 800-786-421

Japan 0066 3382 1699

Korea +82 2 3429 1055

Netherlands 0800.022.2996

New Zealand 0800.440.359

Portugal 800.863.499

Singapore 800.1302.029

Spain 900.938.717

Sweden 020.791.028

Switzerland 0800.564.849

United Kingdom  0800.056.3158
United States (800) 545-6608
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CHAPTER 1:
Overview

This section introduces SafeNet ProtectToolkit-M and shows how SafeNet components and terminology apply
in the Microsoft Cryptographic APl environment.

SafeNet ProtectToolkit-M Applications

With SafeNet ProtectToolkit-M installed, applications that call the Microsoft Cryptographic APl (MSCAPI) can
make use of the secure key storage and high-speed cryptographic processing offered by SafeNet hardware
security modules (HSMs).

The Microsoft Cryptographic APl (MSCAPI) provides security services for a range of applications, such as web-
based SSL processes.

Microsoft Certification Authority (MSCA) and Internet Information Services (lIS) (a Microsoft web server) use
the MSCAPI and therefore may be integrated with SafeNet ProtectToolkit-M. An MSCA may store CA keys on
an HSM, while [IS may use HSM key storage when establishing secure socket layer (SSL) communication.

The MSCAPI Model and SafeNet ProtectToolkit-M

Cryptographic Service Providers
SafeNet ProtectToolkit-M is implemented as a Microsoft Cryptographic Service Provider (CSP).
A CSP is a plug-in cryptographic module that integrates with Microsoft Windows and provides the underlying

key storage and security operations for the Microsoft Cryptographic APl (MSCAPI). The architecture of the
MSCAPI supports the development of non-Microsoft CSPs such as SafeNet ProtectToolkit-M.

SafeNet ProtectToolkit-M includes both “RSA Full” and “RSA SChannel” cryptographic service providers.
These can be used instead of the corresponding Microsoft CSPs to provide hardware-based key storage and
RSA encryption.

MSCAPI Implementation Using SafeNet ProtectToolkit-M

shows how SafeNet HSMs can be utilized as part of a
MSCAPI system, using SafeNet ProtectToolkit-M as a CSP.
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Chapter 1: Overview

Figure 1: SafeNet ProtectToolkit-M model
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Chapter 1: Overview

Each user requiring processing support from the SafeNet ProtectToolkit-M system will need a user keyset
containing a key container. Key containers may contain up to 2 key pairs: a signature key pair and an exchange
key pair.

Apart from this, there are two keysets required by the SafeNet ProtectToolkit-M system for its internal
processes. These are the SYSTEM keyset and the MACHINE keyset, which are visible to all system users.
SafeNet ProtectToolkit-M cannot operate without either of these and will automatically create either set if they
are not present or deleted. Shared keys (accessible by more than one user), such as those generated
automatically when Microsoft CA is installed, will also be stored in one of these keysets when using a SafeNet
ProtectToolkit-M CSP. Generally these shared keys are stored in the MACHINE keyset.

The physical storage location for each keyset is CSP-dependent. By default, Microsoft CSPs store keys to disk,
in user profiles. When using the “Safenet RSA Full” or “Safenet RSA SChannel” CSPs, all keys are secured by
SafeNet ProtectToolkit-M within SafeNet hardware security modules (HSMs).

Further Documentation

The following reference material should be considered in addition to this user manual:
> SafeNet ProtectServer PCle HSM Installation Guide
> SafeNet ProtectServer Network HSM Installation/Configuration Guide

> SafeNet HSM Access Provider Installation Guide

\"

Microsoft documentation on cryptographic service providers. See their web site.
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CHAPTER 2:
Installation

This section details installation and uninstallation components and instructions on the following:
> SafeNet ProtectToolkit-M Runtime
> SafeNet KSP (for CNG)

Requirements

Before beginning with the SafeNet ProtectToolkit-M installation, please confirm that your system meets the
following minimum requirements:

> Microsoft IIS (Internet Information Services) should be installed, configured and working if integration with
[IS is desired.

> A SafeNet ProtectServer hardware security module (HSM) must be available. An adapter can be installed in
the local machine or a device may be made available via a network connection.

Installing the SafeNet ProtectToolkit-M software

If a previous version of SafeNet ProtectToolkit-M is installed, uninstall it prior to installing the newer software.
The latest versions of the client software and HSM firmware can be found on the Gemalto Technical Support
Customer Portal. See for more information.

To install the SafeNet ProtectToolkit-M software:

NOTE Full support for SafeNet ProtectToolkit-M is provided on 64-bit versions of Windows
only. 32-bit versions support KSP only.

1. Open Windows Explorer and execute the file PTKmprt32.msi or PTKmprt64.msi found in <path to
installer directory>\Win64\Ptk-M.

2. Follow the on-screen instructions to complete the installation. During installation you will be required to:
a. choose the directory where the software will be installed, and
b. nominate either a locally connected or network connected HSM as the cryptographic service provider.

Following the installation, continue to for details on how to configure and
setup the SafeNet ProtectToolkit-M product.

SafeNet ProtectToolkit 5.5 User Guide
007-013682-003 Rev. A 08 January 2020 Copyright 2009-2020 Gemalto 1 5



Chapter 2: Installation

KSP (for CNG)

To install the SafeNet KSP for CNG, run the relevant Win32\SafenetKSP32.msi or
Win64\SafenetKSP64.msi installer.

See special KSP configuration instructions in

Uninstalling the SafeNet ProtectToolkit-M software

To uninstall the SafeNet ProtectToolkit-M software:
1. Ifthe key information stored on the HSM is no longer required, tamper the HSM in order to destroy it. See
the Tampering the Adapter section for further instructions if needed.

2. Ifthe PCle HSM access provider is installed, you must uninstall it before uninstalling the SafeNet
ProtectToolkit-M software. Failure to do so may prevent the SafeNet ProtectToolkit-M software from

uninstalling correctly.
3. Usethe Programs and Features control panel to uninstall the SafeNet ProtectToolkit-M software.

SafeNet ProtectToolkit 5.5 User Guide
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CHAPTER 3:
Setup and Configuration

After installing SafeNet ProtectToolkit-M it is necessary for the device administrator to:
initialize the HSM

set the security mode

allocate keyset space

create user keysets (This is optional as users may also create their own keysets)

vV V vV VvV V

setup work load distribution (WLD) if required

After the device administrator has performed the above steps then users will typically need to undertake the
following tasks:

> create keysets
> add containers to keysets
> generate key pairs in containers

To perform these tasks follow the procedures described in this section:

vV V VvV VvV Vv V

User Roles

Prior to performing any configuration, it is important to understand the different SafeNet ProtectToolkit-M roles
available and to determine which type of role an individual will assume.

There are two defined roles available. These are:
> A SafeNet ProtectToolkit-M device administrator; and
> A SafeNet ProtectToolkit-M user

These roles are described below.

SafeNet ProtectToolkit 5.5 User Guide
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Chapter 3: Setup and Configuration

Device Administrator

The device administrator is responsible for tasks that involve management of the associated HSM and those
applicable to SafeNet ProtectToolkit-M administration. Those assigned to this role are also responsible for
performing backup and restore operations for MACHINE and SYSTEM keysets and allocation of space for user
keysets.

User

A SafeNet ProtectToolkit-M user is responsible for the creation and management of their own keyset stored
within a HSM. This includes responsibility for backup and restore of their own keyset, the key container and
associated key pairs.

Initial Configuration: Mandatory Steps

Initializing the HSM

SafeNet ProtectToolkit-M uses a hardware encryption HSM to store sensitive key information. The HSM needs
to be initialized prior to use, or following a tamper event. A tamper event occurs, for example, if the HSM
detects that someone is trying to get inside the cover. It will then automatically erase its secure memory.

HSM management tasks can only be performed by a device administrator. During HSM initialization, the device
administrator password is set, and the HSM clock is synchronized with the host.

To initialize the HSM:

1. Open the Administration Utility by selecting Start > Programs > SafeNet > ProtectToolkit M >
gmadmin. A prompt displays to set the new device administrator password.

2. Enter the password in both the Admin Password and Confirmation fields and, if required, check “Keep
Password For Session”. For added security, leave the “Keep Password For Session” box unchecked.
Password entry will then be required to complete every task. For convenience, check this box so that
password entry will not be required again until after the utility is closed and reopened.

3. Click OK. The MACHINE and SYSTEM keysets are now created. The Administration Ultility dialog box
displays showing MACHINE and SYSTEM keyset icons under Active Adapters as shown below.

Active Adapters

SR ] device:0
{8} MACHINE_Keyset
~o {8} SYSTEM_Keyset

Setting Security Modes and Security Flags

The security mode for the HSM is chosen by specifying the value of a number of security flags. These flags
affect both the services available to the various users of the system as well as specific security features of the
HSM. These flags may be specified individually to set a custom security mode, however it is recommended that
a standard security mode be used. When a standard security mode is selected the flags are assigned values
automatically to meet the requirements for that mode.

SafeNet ProtectToolkit 5.5 User Guide
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Chapter 3: Setup and Configuration

NOTE The security mode should be set prior to commencing normal operation. It is
recommended that the impact of any proposed security mode change be carefully assessed
to be applicable prior to implementation.

To set a security mode:
1. Ifitis not already open, launch the Administration Utility from the Start menu by selecting Start >
Programs > Safenet > ProtectToolkit M > gmadmin.

2. From the All Adapters menu, select Set Security Flags. The Set Security Flags — All Devices dialog
box displays.

set Security Flags - Device 0 x|

— Secunty Mode Flags

[~ Tamper Before Upgrade [~ Lock Securty Mode

[~ Mo Public Cryptography [T Increazed Security Maode

[~ Entruzt Compliant [~ Only Allow FIPS Approved Algarithms
[~ MoClear PINg [~ Full Secure Meszaging Encrption
[~ Authentication Pratection [~ Full Secure Meszaging Signing

— Secunty Modez

FIPS 140 Restiicted | setal | Clear &l |

Cancel |

3. Either:

a. change flag values to those required (see )in the
Security Mode Flags group box

b. click a security mode button in the Security Modes group box to set a standard security mode. See

4. Click OK and enter the administration password if prompted. A confirmation message is displayed.
5. Click OK to return to the Administration Utility dialog box.

Security Mode Descriptions

This section describes the security modes that can be selected from the Security Modes group box in the Set
Security Flags — All Devices dialog box.

Set All and Clear All Modes
> Click Set All to set all available security flags.

> Click Clear All to remove all security flags.

SafeNet ProtectToolkit 5.5 User Guide
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Chapter 3: Setup and Configuration

FIPS 140 Mode

FIPS 140 Mode refers to the security flag settings required to comply with the Federal Information Processing
Standards (FIPS) 140 standard.

Itis important to note that the product can function outside the scope of this accreditation. Therefore, ensure
that the correct configuration is set if this level of FIPS secure operation is required.

The security mode flags setin FIPS 140 mode are shown in the table below.

Restricted Mode

The Restricted Mode security setting is a compromise between performance and security. If Restricted Mode
is selected, then the HSM will require all users to identify themselves before cryptographic services are
available. This mode also inhibits any clear PINs or sensitive key material from passing through the HSM’s
PCle bus interface but each individual request to the HSM does not need to be signed.

The security mode flags set in Restricted Mode are shown in the table below.

Security Mode Preconfigured Flag Settings

When the FIPS or Restricted security mode buttons are clicked in the Set Security — All Devices dialog
box, the status of the flags is changed as shown in the table below (default values). Those settings marked with
an asterisk (*) are mandatory in order to implement the requirements for the mode concerned. Additional flags,
marked with a plus (+), can be changed if required. See

Flag FIPS 140 Mode Restricted Mode
Tamper Before Upgrade. Set* Cleared+
No Public Cryptography Set* Set*
Entrust Compliant Cleared” Cleared*
No Clear PINs Set” Set*
Authentication Protection Set* Cleared”
Lock Security Mode Set* Set*
Increased Security Mode Cleared+ Cleared+
Only Allow FIPS Approved Algorithms. Set* Cleared*
Full Secure Messaging Encryption Cleared+ Cleared+
Full Secure Messaging Signing Cleared+ Cleared*

SafeNet ProtectToolkit 5.5 User Guide
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Chapter 3: Setup and Configuration

Security Mode Flag Descriptions

Tamper Before Upgrade
When this flag is set, the HSM will automatically perform a soft tamper (erase all internal secure memory) as
part of a firmware upgrade, FM download, or FM disable operation.

No Public Cryptography
When this flag is set, no user can perform a cryptographic operation without having authenticated themselves.

When this flag is set, each token in the system will have the PKCS #11 CKF_LOGIN_REQUIRED flag set, to
indicate that applications must authenticate before operations. This security flag does not affect the Admin
token, which always requires authentication for use.

NOTE This setting does not impede the ability to perform RSA or other public key
processing. It ensures that crypto services cannot be performed by unauthenticated users.

Entrust Compliant
When this flag is set, Entrust Compliant Mode is operational, ensuring compatibility with the Entrust range of
applications. These applications require a specific security profile to operate correctly.

No Clear PINs

When this flag is set, no user PINs or other sensitive information may be passed across the host interface in an
unencrypted form. This enables secure messaging encryption between applications and the HSM. It will also
disable certain functions that would otherwise result in the clear transmission of sensitive data. This flag will
also not allow any keys to be created with the attribute CKA_SENSITIVE=FALSE.

Authentication Protection

This flag, when set, enforces secure messaging authentication between applications and the HSM. Each
request to the HSM must be digitally signed and will be verified by the HSM. The key used for this signing
process is derived from a key shared by the HSM and host application as well as the user PIN.

Applications will operate in a more secure manner with this flag set, but HSM performance will suffer due to the
additional operations required to sign each request and response message.

Lock Security Mode

The Lock Security Mode flag, when set, disables further modification of the security mode flag settings. Once
set, this flag (or any other security mode flag) cannot be modified. A new security mode can only be
implemented after a tamper operation is performed.

Increased Security Level
The Increased Security Level flag, when set, disables the mechanism CKM_EXTRACT_KEY_FROM_KEY and
also does not allow the CKA_MODIFIABLE attribute to be changed from False to True.
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Only Allow FIPS Approved Algorithms
The Only Allow FIPS Approved Algorithms flag, when set, disables the following non-FIPS-approved
algorithms: MD2, MD5, RIPE, CAST, IDEA, RC2, RC4 and RC5.

Full Secure Messaging Encryption

The Full Secure Messaging Encryption flag is similar to the No Clear PINs flag, except that every message is
encrypted in both directions between the application and the HSM. The key used for the message encryption is
generated using the PKCS#3 Diffie-Hellman Key Agreement Standard.

This flag only performs two-way encryption when using the SafeNet ProtectToolkit-M client library in the
client/server mode over TCP/IP.

Applications will operate in a more secure manner with this flag set, but HSM performance will suffer due to the
additional operations required to sign each request and response message.

Full Secure Messaging Signing

The Full Secure Messaging Encryption flag is similar to the Authentication Protection flag, except that every
request in both directions between the application and the HSM is digitally signed and verified. The key used
for the message encryption is generated using the PKCS#3 Diffie-Hellman Key Agreement Standard.

This flag only performs two-way encryption when using the SafeNet ProtectToolkit-M client library in the
client/server mode over TCP/IP. Applications will operate in a more secure manner with this flag set, but HSM
performance will suffer due to the additional operations required to sign each request and response message.

Allocating Keyset Space

In order for applications to use SafeNet ProtectToolkit-M's key storage facilities, keyset space must be
allocated on the HSM. Enough space should be allocated to accommodate the number of users requiring key
storage.

Allocation of keyset space is the responsibility of the device administrator and is performed using the SafeNet
ProtectToolkit-M administration utility.

NOTE Itis important to determine how many key sets may be needed over time and to
allocate sufficient space so that additional key sets can be created without the need for a
server shutdown.

To allocate keyset space:

1. Launch the Administration Utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gtadmin.

2. Select the device on which to create keyset space from the Active Adapters list.
3. Openthe Adapter menu and choose Allocate Space.
The Administration Utility prompts for the device administrator password.

Following correct password entry, the new keyset space is displayed under the device as shown below.
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— Active Adapters
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Creating User Keysets

A user keyset is required for each individual that will use the SafeNet ProtectToolkit-M system. The keysets are
stored on the HSM in available keyset spaces. This means that in order to create a user keyset, a free keyset
space must be available (see above).

Creating user keysets is the responsibility of the device administrator and is performed using the SafeNet
ProtectToolkit-M administration utility.

NOTE Ideally, all necessary keysets should be created prior to the system becoming
operational. If this is not feasible, it is important to estimate how many key sets may be
needed over time and to allocate sufficient space so that additional key sets can be created
without the need for a server shutdown.

To create a user keyset:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmadmin.

2. Select the spare keyset space on which to create the keyset from the Active Adapters list.
3. Open the Keyset menu and choose Create Keyset.
The administration utility prompts for the Keyset Name and the Keyset Password.

4. Enter the required information into the fields provided and click OK to create the new keyset. Note that the
name of the keyset should match with the user login name. The new keyset displays under the device as
shown below.

— Active Adapters
=4 Al

{3} ADMINISTRATOR_Keyset
MACHIME _Kepzet
STSTEM_Keyset

Commencing Normal Operation
Following the above steps, SafeNet ProtectToolkit-M is ready for use. Additional configuration may be required
in certain circumstances, as covered in

The device administrator or user might need to perform various operational tasks during runtime usage. These
tasks are covered in the following chapters.
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Configuration Options

Registry Configuration

Entries made in the Windows registry during the installation of SafeNet ProtectToolkit-M are documented in

. These may be amended by expert users if required. Generally, the
default values will not need to be changed. The exceptions are the Debug Level and User Keyset Password
entries used to control error log file creation and silent user keyset login respectively. See the sections below
for further information.

Error Log File Creation

The Debug Level registry key controls error log file creation. By default, the value of this key is set so that no
error log file is produced. Should it be necessary to create an error log file, see for
more options.

Silent User Keyset Login

While access to the Machine and System keysets is open, access to a User keyset requires authentication.

Typically, User keyset access authentication is achieved by prompting the user for a password when access is
requested. This is not convenient/permissible in all situations, so silent user keyset login is also available.

To activate silent User keyset login:

Add the following value to the Windows registry:

HKEY CURRENT USER/Software/Safenet/ProtectToolkit M/
UserKeysetPassword=<password>

where <password> is the clear text password for the User keyset.

Since this value is located in the Current Users registry hive (which is only accessible/visible when a user
authenticates themselves to the Windows operating system) there is no security risk, even though the
password is stored in the clear.

Work Load Distribution (WLD)

If required, more than one hardware security module (HSM) can be used in a Work Load Distribution (WLD)
configuration.

WLD allows work to be balanced across a system by transferring units of work among HSM processing
modules during execution, reducing the demand on any particular processing module. This produces an
increase in the system's overall throughput of processing tasks. Using multiple HSMs in this way also provides
redundancy. If an HSM goes down, the work will automatically be shared amongst the remaining operational
HSMs.

For further information, including implementation and maintenance instructions, refer to
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KSP (for CNG) Configuration

The registration tool KspConfig.exe, installed by the 64-bit Client software installer into the C:\Program
Files\SafeNet\Protect Toolkit 5\KSP directory, registers HSM Partitions for use with CNG. It secures the
Password for each HSM Partition such that only the user for which the Password was secured is able to un-
secure it.

1. Goto C:\Program Files\SafeNet\Protect Toolkit 5\KSP and launch KspConfig.exe (the KSP
configuration wizard).

2. Inthe left-hand pane (tree view) double-click "Register Or View Security Library"

3. Inthe right-hand pane, browse to the library C:\Program Files\SafeNet\Protect Toolkit 5\Protect
Toolkit C SDK\bin\hsm\cryptoki.dll and click Register.

- SafeMet-Inc Key Storage Provider, Config Wizard \;li-
File Help

[=]- SafeMet KSP Config

Register Or View Security Library
" Register HSM Slots LibraryPath |G:\Program Files\SafeMetiProtect Toolkit 5\Protect Toolkit C SDK\binthsmicryptoki.dll |

Register

Ready MUM

4. Return to the left-hand pane and double-click “Register HSM Slots” and click Next.
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File Help

|
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| Administrator
Available Slots

j | WIN-BFI9SFMM30K

Slot Password

j + Slot Label

[0 wLD_s1 ~||

| " Slot Number

Registered Slots

Register Slot

View Registered Slots

5. In the Slot Password field, type in the password for the indicated slot.

To the right of the window, click the “Register Slot” button.

File Help

Delete Registered Slot

M

|

=1-SafeMet KSP Config
Register Or View Security Library
... Register H5M Slots

6. Return to the Domain pull-down list and select "NT AUTHORITY," supply the password for the slot being

Register For User Diomain

Register By

| Administrator
Available Slots

| | WIN-BFISSFMM30K
Slot Password

j * SlotLabel

|o wLD_s1

o [

| " Slot Number

Registered Slots

Register Slot

View Registered Slots

Delete Registered Slot

_ Nom[

registered, and again click “Register Slot” to complete the KSP configuration.
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File Help

[=]-5afeMet KSP Config
Register Or View Security Library
.. Register HSM Slots

Reqister For User Domain Reaqister By
ISYSTEM -] INTAUTHDRITY ~| | @ siotLabel

Available Slots Slot Password

[0 wLD_s1 o] [ | | Stot Number

Register Slot
View Registered Slots

Reqgistered Slots

Delete Registered Slot

 Nm |

Once you have the slots registered, you can begin connecting with your client application to perform crypto
operations in your HSM.

Configuring [IS7 (Win2008) with CNG

This section describes how to configure Microsoft Internet Information Services 7 (11S7) on Windows Server
2008 for use with CNG.

To configure [IS7 on Windows Server 2008 for use with CNG

1. Install and configure your HSM.
2. Install and configure KSP:
a. Register your cryptoki.dll file
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File Help

|

- SafeMet KSP Config
Register Or View Security Library
L...Register HSM Slots LibraryPath |G:\Program Files\SafeNetiProtect Toolkit 5\Protect Toolkit C SDKbinthsmicryptoki.dil |

Register |

b. Register your slot for Administrator/(Server name or Domain name) and again for System/NT Authority.

File Help

|

- SafeMet KSP Cenfig
‘.. Register Or View Security Library —
N ;e qgister HSM Slots | Administrator v | WIN-BFIGSFMM30K ~| | slotLavel

Available Slots Slot Password
[0 wLD_s1 | | | € Stothumber

Register For User Domain Register By

Register Slot

View Registered Slots

Registered Slots

Delete Registerad Slot

[ Nom[

3. Create a policy file to generate a cert request. Normally, you can do this directly through the GUI, but the
KSP is not yet recognized through the GUI. The policy file (call it policy.inf) should look like this:

[New Request]
KeyUsageProperty = “NCRYPT ALLOW DECRYPT FLAG”
Providertype = 1
RequesterName = OTT1-HANNIBAL\Administrator
RequestType = PKCS10
ProviderName = “SafeNet Key Storage Provider”
Subject = “CN=OTT1-HANNIBAL, OU=Eng,O=SafeNet-Inc,
L=0Ottawa, S=Ontario, C=CA”
KeyContainer = “OTT1-HANNIBAL”
MachineKeySet = true
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HashAlgorithm = shal
KeyAlgorithm = RSA
KeyLength = 2048

4. Using the above file, create your cert request:

C:\>certreq -new policy.inf cert.req

5. Submit your cert request to a CA and obtain a signed cert, and the root cert of the CA. Move these
certificates to your IIS server.

6. Install the root certificate:
a. Open the root cert file and select “Install Certificate.”
b. Atthe Welcome screen, click Next.

c. You'll need to specify the Certificate Store to be used. Select the “Place all certificates in the following
store” radio button, and click the “Browse...” button.

d. Inthe Select Certificate Store window that opens, put a check in the “Show physical stores” box, locate
and expand Trusted Root Certification Authorities and select “Local Computer” then click OK.

Seleck Certificate Store

Select the certificate store wou want to use,

| Personal -
El | Trusted Root Certification Authorities

- | Registry

I S FLocal Computer

o] smart Card

+-—| Frtrrnrise Triisk h
d o

¥ show physical skores

Ik I Zancel |

7. Open Server Manager and select “Add Roles” to install Web Server (lI1S). Configure to your needs, though
the default options will do for the purposes of this document.

8. When the installation is complete, expand the Roles tree from the left-hand pane, then expand Web Server
(I1IS) and select “Internet Information Services (11S) Manager,” then select the object name (most likely your
server’s name) from the Connections pane, as shown below:
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9. Under the Home pane, open Server Certificates, then select “Complete Certificate Request...” from the
Actions pane.

10.Complete the form that opens; select the path to your certificate and choose a friendly name for said
certificate and click OK:

Complete Certificate Request E E3 |

| | Specify _LDertifil:atEL Authnritlf RespunJ_E | | | |

ﬁ“‘i | |

Complete a previously created certificale request by retrieving the file that conzains the cert ficate
authority's response,

File_ name conkaining the cartification atharity's response:

Ix:'l,certnew.n:er v |

Friendly name:

Iu:uttl-kratu:-s|

(als I Cancel

11.The certificate list will then be populated by the certificate you specified:
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| |
&1 |Server Certificates |
- b

S
"Use this Feature ta requegt and manage certificakes that the \Web server can use
with Web sibes configured For S5L.

| Issued By

Mame = | Issued To

itk 1 -kratos OTT1-KRATOS rnocnrnonkey-Cé

al |

i

E Features Wiew |, _ Conkent Yigw | | |

12.Under the Connections pane, expand the server hostname tree (in the example below, OTT1-HANNIBAL),

then expand the Sites tree, and select “Default Web Site”:
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13.Select “Bindings” from the Actions pane on the right-hand side. This opens the Site Bindings box.

Tvpe | Host Mame | Pork | IP Address | Bind add...
http 80 *

Edit...

Bemove

1 | ] Browse

Close

il

14.Click Add, and make the following selections:
Type https

IP Address Can be left as “All unassigned”

Port Can be left as 443
SSL Select the friendly name you assigned earlier to your certificate when your completed the cert
certificate request.
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Add Site Binding EHE |

Type: IF address: Part:
Ihttps j I.ﬁ.ll Unassigned j |443
Hosk name:

53L certificate:

otk 1-hannibal

Click OK to continue.

15.Under the actions pane, you will now have a link labeled “Browse *:443 (https)” (this may appear slightly
different, depending on the IP Address options you set in the previous step).

Manage Web Site A

-~ Restark
Skart
B stop

Browse Web Site
[@]| Browse *:80 (http)
[@] Browse *:443 (https)

Advanced Settings...

Configure

Limits...

© Help
Cnline Help

16.Select this link and it will show you your default webpage over a secure connection. Configure your website

as needed.
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Administrative Tasks

This section describes the operational procedures a device administrator may perform during normal SafeNet

ProtectToolkit-M operation. It contains:

>

V V V vV vV V V V V V Vv V

Changing the Device Administrator Password

The device administrator can perform a password change at any time and on any token.

Changing the device administrator password may only be performed by the device administrator, using the
SafeNet ProtectToolkit-M administration utility.

To change the device administrator password:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmadmin.

2. Select the device on which to change the device administrator password from the Active Adapters list.
3. Open the Adapter menu and choose Change Device Admin Password.

4. The administration utility will now prompt for the current and new device administrator password.
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NOTE Any existing backups of the MACHINE and SYSTEM keysets will no longer be useful
following a device administrator password change, because the backup key is generated
from the password. New backups must be created after changing the password.

Allocating Keyset Space

When additional user keysets are required, the system will need to be configured for additional keyset space.
The number of allocated keyset spaces determines how many separate SafeNet ProtectToolkit-M users, and
keysets, the system can have.

Allocation of keyset space is the responsibility of the device administrator and is performed using the SafeNet
ProtectToolkit-M administration utility.

To allocate keyset space:

1. Ifitis not already open, launch the administration utility from the Start menu by selecting Start >
Programs > SafeNet > ProtectToolkit M > gmadmin.

Select the device on which to create keyset space from the Active Adapters list.
Open the Adapter menu and select Allocate Space.

The administration utility will now prompt for the device administrator password.

o & 0b

Following correct password entry, the new keyset space will be displayed under the device.

NOTE Additional keyset space cannot be allocated if an application is currently using
SafeNet ProtectToolkit-M. See Session EXxists Errorin

To check if an application has any open sessions to SafeNet ProtectToolkit-M, check the value shown next to
Application Count in the System section of the administration utility. This will need to be “1”, and the Total
Session Count must be “0” in order for keyset de-allocation to succeed.

NOTE If the value of Application Count is shown as “UNAVAILABLE”, your HSM firmware
doesn’t support live application counting. In such a case, it is advisable to upgrade the HSM
firmware to the latest version. Please refer to

De-allocating Keyset Space

If there are keyset spaces which are not likely to be used, it is good practice to de-allocate spare spaces from
the HSM in order to prevent memory exhaustion or invalid use.

De-allocation of keyset space is the responsibility of the device administrator and is performed using the
SafeNet ProtectToolkit-M administration utility.
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To de-allocate keyset space:

1.

a oD

Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmadmin.

Select any spare space from the Active Adapters list.
Open the Keyset menu and choose Deallocate Space.
The administration utility will now prompt for the device administrator password.

Following correct password entry, the spare keyset space will be removed from the list of displayed keysets.

NOTE Keyset space cannot be de-allocated if an application is currently using SafeNet
ProtectToolkit-M. See Session EXxists Errorin

To check if an application has any open sessions to SafeNet ProtectToolkit-M, check the value shown next to
Application Count in the System section of the administration utility. This will need to be “1”, and the Total
Session Count must be “0” in order for keyset de-allocation to succeed.

NOTE If the value of Application Count is shown as “UNAVAILABLE”, your HSM firmware
doesn’t support live application counting. In such a case, it is advisable to upgrade the HSM
firmware to the latest version. Please refer to

Creating User Keysets

In order to create a new keyset for a specific user, you will first have to make sure that there is spare keyset
space available on the HSM. This can be done by opening the SafeNet ProtectToolkit-M administration utility.

Should no spare space be available, you will have to allocate additional keyset space on the HSM. For details,
please refer to the appropriate section above.

I NOTE Users can create keysets for themselves once space is available.

To create a user keyset:

1.

Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmadmin.

Select the spare keyset space on which to create the keyset from the Active Adapters list.

3. Open the Keyset menu and choose “Create Keyset.”

The administration utility will now prompt for the Keyset Name and the Keyset Password. Enter the required
information into the fields provided and press OK to create the new keyset.

I NOTE The name of the keyset should match with the user login name.

The new keyset is displayed under the device.
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Deleting a Keyset

Deleting user keysets is the responsibility of the device administrator and is performed using the SafeNet
ProtectToolkit-M administration utility.

To delete a user keyset:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmadmin.

2. Select the desired keyset from the Active Adapters list.
3. Open the Keyset menu and choose Delete Keyset.

4. The administration utility will now prompt for the device administrator Password. Prior to deletion, the
administration utility will prompt for confirmation that deletion is the requested operation.

5. The keysetis removed from the displayed keysets under the selected device.

NOTE A keyset cannot be deleted if an application is currently using SafeNet ProtectToolkit-
M. See Session Exists Errorin

To check if an application has any open sessions to SafeNet ProtectToolkit-M, check the value shown next to
Application Count in the System section of the administration utility. This will need to be “1”, and the Total
Session Count must be “0” in order for the keyset deletion to succeed.

NOTE If the value of Application Count is shown as “UNAVAILABLE”, your HSM firmware
doesn’t support live application counting. In such a case, it is advisable to upgrade the HSM
firmware to the latest version. Please refer to

Setting the Adapter Transport Mode

The adapter transport mode allows an adapter HSM to be removed from the host system PCI bus without
causing a tamper condition. A tamper will remove all sensitive material from the adapte,r including the adapter
configuration, all keys, and certificates.

Setting the adapter transport mode is the responsibility of the device administrator and is performed using the
SafeNet ProtectToolkit-M administration utility.

To set the adapter transport mode:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmadmin.

2. Select the desired adapter from the Active Adapters list.
3. Openthe Adapter menu and choose Set Transport Mode.

4. The device administrator is now prompted to choose one of three possible transport modes:
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None: To be applied when adapter is installed and configured. This mode will tamper the adapter if
removed from the PCle Bus.

Single -Adapter: Will not be tampered after removal from the PCle bus. Adapter will automatically change
to “None” Transport Mode the next time the adapter is reset or power is removed and restored.

Continuous -Adapter: Will not be tampered by being removed from the PCle bus.

5. The administration utility will now prompt for the device administrator password.

NOTE The transport mode does not disable the tamper response mechanism entirely. Any
attempt to physically attack the adapter will still result in a tamper response.

Correcting Clock Drift

Due to host system and HSM timing differences, such as clock drifts, it may become necessary, at certain
stages, to adjust the internal time on the HSM.

Note that the HSM clock value cannot be specified directly. It is only possible to synchronize the HSM clock with
the host system clock.

Synchronizing the HSM clock is the responsibility of the device administrator and is performed using the
SafeNet ProtectToolkit-M administration utility.

To adjust the HSM clock:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmadmin.

2. Select the desired HSM from the Active Adapters list.
3. Open the Adapter menu and choose Sync Clock.

4. The administration utility will now prompt for the device administrator password. Correct entry of the
password will result in clock synchronization.

Viewing and Purging the HSM Event Log

SafeNet ProtectServer HSMs maintain event logs in order to provide a means of tracking serious hardware or
consistent operational faults. It is the device administrator’s task to view and purge HSM event log data. For full
details on what the event log stores and how to interpret its data, please refer to

When the HSM event log is full, the HSM will no longer store new event records and will need to be purged.

I NOTE The HSM event log cannot be purged until it is full.

To view the HSM event log:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmadmin.

2. Select the desired HSM from the Active Adapters list.
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3. Open the Adapter menu and select View Event Log.

4. The administration utility will now prompt for the device administrator password. Correct entry of the
password will result in the event log being displayed.

5. The eventlog is shown as a series of pages. If there are more than one page of event log entries, the
operator can navigate through the pages via the first, prev, next, last buttons.

To purge the event log:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmadmin.

2. Select the desired HSM from the Active Adapters list.
3. Open the Adapter menu and choose Purge Event Log.

4. The administration utility will now prompt for the device administrator password. Correct entry of the
password will result in the event log being purged.

NOTE The eventlog can also be purged via the View Event Log dialog by clicking the
Purge button.

Checking and Upgrading HSM Firmware

The SafeNet ProtectToolkit-M firmware that operates on the HSM can be upgraded to newer versions. This
facility will only allow the HSM to be upgraded to firmware versions that have been digitally signed by SafeNet.

The firmware update package, formerly supplied identically on both the SafeNet ProtectToolkit-C and SafeNet
ProtectToolkit-M DVDs, is now available only from the Gemalto eService Support Portal, along with a specific
Update instruction document. The instructions in this section are generic in nature, intended only to show the
scope of the operation. The authoritative, detailed instructions are always in the Update document that
accompanies the update package. The latest versions of the client software and HSM firmware can be found
on the Gemalto Technical Support Customer Portal. See for more information.

Prior to performing a firmware upgrade, the firmware upgrade file should be checked to confirm that it is a valid
SafeNet upgrade file.

Depending on the security policy in place, the HSM may perform a soft-tamper before the upgrade process is
executed. This tamper will erase all key and configuration data on the HSM. Prior to performing a firmware
upgrade, ensure that you have performed the following:

> Allimportant user data and keys have been backed up
> The current HSM configuration has been noted

> All applications using the HSM have been closed — this may require some services to be stopped (e.g.
Certificate Services, IIS)

Upgrading the HSM firmware is the responsibility of the device administrator and is performed using the
SafeNet ProtectToolkit-M administration utility.
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To check the firmware upgrade file:

1. Ifitis not already open, launch the administration utility from the Start menu by selecting Start > Programs
> SafeNet > ProtectToolkit M > gmadmin.

Select the desired HSM from the Active Adapters list.
Open the Adapter menu and choose Check Firmware File.

The administration utility will now prompt for the location of the firmware upgrade file.

a oD

The utility will show if the file is validated, or corrupt.

To upgrade the HSM firmware:

1. Ifitis not already open, launch the administration utility from the Start menu by selecting Start >
Programs > SafeNet > ProtectToolkit M > gmadmin.

Select the desired HSM from the Active Adapters list.
Open the Adapter menu and choose Upgrade Firmware.

The administration utility will now prompt for the location of the firmware upgrade file.

o & 0b

If the file is validated, the utility will prompt for the device administrator password. Correct password entry
will proceed with the firmware upgrade.

NOTE During the firmware upgrade the administration utility will appear to stop functioning.
This is normal since firmware upgrades can take up to 40 seconds to complete. If the utility
does not respond after a number of minutes, shut down your system and reboot. If problems
persist, see to contact SafeNet technical support.

Tampering the HSM

The tampering of the HSM may be necessary at the end of its lifecycle or any other security-sensitive event that
requires all stored data to be immediately destroyed.

Atamper formats the secure memory of the HSM and thereby erases all configuration and key data.

Due to the highly destructive nature of this action, tampering the HSM is the responsibility of the device
administrator and is performed using the SafeNet ProtectToolkit-M administration utility. Note that this action
also requires that all sessions have been closed and that no user is accessing the HSM.

To tamper the HSM:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmadmin.

2. Select the desired HSM from the Active Adapters list.
3. Open the Adapter menu and choose Tamper.

4. The administration utility will now prompt for the device administrator password. Correct entry of the
password will show a final confirmation dialog to ensure that this is the desired course of action.

5. Press Yes to tamper the HSM, or No to Cancel.
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NOTE The above action cannot tamper the HSM while other applications are active. The
administration utility will indicate if the tamper operation was successful. A white cross on a
red background shown next to the selected HSM indicates that the device is tampered.

Backing up a Keyset

Individual, HSM stored keysets can be backed up to a secure disk file or one or more smart cards. Backed up
keysets can then be restored in the event of a tamper to the HSM or if the keysets are otherwise lost.

NOTE Users are responsible for backing up their own keysets and the SafeNet
ProtectToolkit-M device administrator is responsible for backing up the MACHINE and
SYSTEM keysets.

Atriple-DES BackupKey is used to encrypt each keyset prior to storage on a smart card. A different BackupKey
is automatically created for each keyset when the keysets are created but these keys are not visible under
normal SafeNet ProtectToolkit-M operation. A BackupKey for a keyset is derived from a combination of the
password used to secure that particular keyset and the keyset name. In the case of the MACHINE and
SYSTEM keysets, the device administrator’s password and the keyset name are used to derive the key. Thus
to restore a keyset that was previously backed up, the same password and keyset name must be used.

Keyset backup and restore is accomplished with the command line utility ctkmu. Please refer to for the
complete ctkmu reference.

Preparation
Prior to attempting a keyset backup, please ensure that you have:

> avalid keyset that can be backed up
> if backing up to smart cards, a smart card reader connected to the HSM, and

> sufficient smart cards or disk space to back up the required data.

Procedure
1. Obtain a listing of all keysets by executing ctkmu | from a command prompt.
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&™ Administrator: Command Prompt | == X

C:v>ctkmu 1
ProtectToolkit C Key Management Utility 5.3.0
Copyright (c¢) Safenet, Inc. 2009-2016

n »

Cryptoki Uersion 2.20
Safenet, Inhc.

USER_03_Keyset
USER_04_Keyset
AdminToken (518687T)

2. Record the slot number for the keyset you wish to backup.
3. Tobackup a keyset to a file, from a command prompt, type the following, substituting the slot number of the
keyset to backup for n and the name of the file to back up to for fileName:

ctkmu x -sn -wBackupKey filename

NOTE When backing up the MACHINE_Keyset or the SYSTEM_Keyset, enter the default
value password as the user password. The device administrator’s password and the keyset
name will be used to derive the BackupKey in these instances.

Example

In the example below, the keyset on slot 0 will be securely encrypted using the key BackupKey (created from
the user password for the keyset and the keyset name) and backed up to the disk file named
MachineKeyset.bak. This operation will prompt for the user password for the keyset.

ctkmu x -s0 -wBackupKey MachineKeyset.bak

@A Administrator: Command Prompt | = | [E] |-

C:\>ctkmu x -s2 -wBackupKey MachineKeyset .bak
ProtectToolkit C Key Management Utility 5.3.0
Copyright (c) Safenet, Inc. 20089-2016

Keyset_01_01_Container SUCCEEDED
Keyset_01_01_Exchange SUCCEEDED
Keyset_01_01_Exchange SUCCEEDED

C:\>n
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Restoring a Keyset

Precautions
> Torestore a key that was previously backed up, the same password and keyset name must be used.

> Extreme care should be taken to ensure that keys which are being restored DO NOT already exist on the
SafeNet ProtectToolkit-M system. A restore operation DOES NOT replace existing keys, but will restore a
second instance of the same key pair. If you have accidentally created multiple instances of the same key
pair, SafeNet ProtectToolkit-M will mark the affected keyset as being invalid. Please refer to
for details on how to address this type of problem.

To restore a keyset:
1. Create a new keyset with the same name and password as the original. See the section in
for the procedure.

2. Torestore a keyset from file, from a command prompt type the following, substituting the slot number of the
keyset to restore for n and the name of the file containing the keyset for fileName.

ctkmu i —-sn -wBackupKey filename

NOTE When restoring the MACHINE_Keyset or the SYSTEM_Keyset, enter the default
value password as the user password. The device administrator password used to create
the backup will also be prompted for.

Example

The example below will import a keyset to the token in slot 0 from a disk file named MachineKeyset.bak and
unwrap, or decrypt, the data with the key which has a label of BackupKey. This operation will prompt for the
user password for the keyset.

ctkmu i -s0 -wBackupKey MachineKeyset.bak

Enabling Private Key Clear Export

In order to support the key archival process, it must be possible for the host machine to obtain the value of the
private key in the clear.

Due to the inherent security risks, the Allow Clear Export of Private Keys flag controls whether this value can be
obtained. This is a “secure configuration item”.

A secure configuration item is one which is open for reading, but requires authentication for writing. Such
configuration items are stored on the HSM and protected by the password of the device administrator.

If Allow Clear Export of Private Keys flag is setto True, then itis possible to obtain the value of a private key in
the clear using the Microsoft Crypto APl (MSCAPI) (causing the key archival process to succeed).

If Allow Clear Export of Private Keys is setto False, then any requests to obtain the value of a private key in
the clear are denied (causing the key archival process to fail).
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The value of the Allow Clear Export of Private Keys flag can be changed using the SafeNet ProtectToolkit-M
Administration Utility.

To set or clear the Allow Clear Export of Private Keys flag:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmadmin.

2. Select the desired HSM from the Active Adapters list.

3. Open the Adapter menu and choose Set Secure Configuration. The Set Secure Configuration dialog
box displays.

Fa Set Secure Configuration - Device O 8 |

— Secure Configuration

[~ Allows Clear Export of Private Keps

OE.

4. Setor clear the Allow Clear Export of Private Keys flag as required, then click OK to action the change.
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This section describes the operational procedures a User may perform during normal SafeNet ProtectT oolkit-
M operation. It contains sections on the following operations:

>

V V VvV VvV VvV Vv V

Creating Keysets

To create a new keyset, first ensure that there is enough keyset space available on the HSM. This can be
confirmed by opening the SafeNet ProtectToolkit-M Administration Utility.

If there is not enough space available, an administrator will have to allocate additional keyset space on the
HSM. For details please refer to the previous chapter.

To create a keyset:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmadmin.

2. Select the spare keyset space on which to create the keyset from the Active Adapters list.
3. Open the Keyset menu and choose Create Keyset.

4. The administration utility now prompts for the Keyset Name and the Keyset Password. Enter the required
information into the fields provided and press OK to create the new keyset.

I NOTE The name of the keyset should match with the user login name.

5. The new keyset is displayed under the device.
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Changing a Keyset Password

A keyset password may need to be changed periodically. A keyset password is changed by the keyset owner,
using the SafeNet ProtectToolkit-M keyset management utility.

To change the keyset password:

1. Launch the keyset management utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmksm.

2. From the displayed list, select the desired keyset.
3. Open the Keyset menu and choose Change Password.

4. The useris prompted for the current and new keyset password. Enter the required information into the
fields provided and press OK to change the password.

NOTE Any existing keyset backups will no longer be useful following a keyset password
change, because the backup key is generated from the password. New backups should be
created after changing the password.

Adding a Key Container

Key containers are created within a user’s keyset, so that the keyset can hold key pairs. The keyset owner can
add a key container using the SafeNet ProtectToolkit-M keyset management utility.

To add a key container:

1. Launch the keyset management utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmksm.

2. From the displayed list, select the desired keyset.
3. Open the Keyset menu and choose Add Container.

4. The user is prompted for the keyset password and key container name. Enter the required information into
the fields provided and press OK to create the key container.

Removing a Key Container

Key containers which are no longer required or hold obsolete key pairs may be removed from a keyset.

Removing a key container is performed by the keyset owner, using the SafeNet ProtectToolkit-M keyset
management utility.

To remove a key container:

1. Ifitis not already open, launch the keyset management utility from the Start menu by selecting Start >
Programs > SafeNet > ProtectToolkit M > gmksm.

2. Select the keyset container which you wish to remove.
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3. Open the Keyset menu and choose Remove.

4. The useris prompted for the keyset password and confirmation that the container removal is the required
action. Press OK to remove the key container.

Generating a Key Pair

Key pairs are used by Crypto API to encrypt or sign data. There are two types of key pairs, and they must be
created inside a key container. Please refer to

The keyset owner can generate a key pair using the SafeNet ProtectToolkit-M keyset utility.

To generate a key pair:

1. Launch the keyset management utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmksm.

2. Select the keyset container in which to generate a key pair.

3. Open the Container menu and choose Generate Key Pair.

»

The user is prompted to enter the keyset password. Correct password entry will display the generate key
pair dialog.

The generate key pair dialog will prompt for the key usage and key size.
Choose Exchange or Sign depending on the required key pair usage.
Select a Key Size from the drop-down list.

Check the Exportable checkbox if you want to be able to back up this key pair.

© ® N o

Press OK to generate the key pair.

Key Usage
Key pairs generated using the keyset management utility have one of two usage attributes. These are:

> Exchange: This type of key pair is used to encrypt session keys for the user during normal SafeNet
ProtectToolkit-M operation.

> Sign: This type of key pair is used to create digital signatures for the user during normal SafeNet
ProtectToolkit-M operation.

Each user will generally require both types of keys within their particular keyset.

Key Size

Key size is an important consideration when using encryption as a security measure. When discussing key
size, the value is given as a bit length, referring to how many digits are represented in the key value. As a
general guideline, longer bit lengths produce longer keys and more secure encryption. However, larger key
sizes slow the encryption process, due to the larger calculations involved.

Deleting a Key Pair

The keyset owner can delete a key pair using the SafeNet ProtectToolkit-M keyset management utility.
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To delete a key pair:

1. launch the keyset management utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmksm.

2. Select the key pair you wish to delete.
3. Open the KeyPair menu and choose Delete.

4. The useris prompted to enter the keyset password. Correct password entry deletes the selected key pair.

Displaying Key Pair Properties

Key pair properties can be displayed by any user of the SafeNet ProtectToolkit-M keyset management utility.

To display the properties of a key pair:

1. Launch the keyset management utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmksm.

2. Select the key pair for which to display its properties.

3. Open the KeyPair menu and choose Properties.

Information shown includes the following:

> Keyset: Displays the name of the keyset on which the selected key pair resides.

> Container: Displays the name of the key container in which the selected key pair resides.

> Usage: Shows the key usage attribute of the selected key pair. This value will either be “EXCHANGE” or
“SIGN”.

> Size: Shows the key size for the selected key pair.

> Private Key Held: This indicates if the private key for the selected key pair is present as part of the key pair.
Since it is possible to import a public key only, this value will either be “TRUE” or “FALSE”".

> Exportable: Indicates whether the selected key pair can be backed up.

Backing up and Restoring Keysets

Users are responsible for backing up their own keysets. The procedures involved in backing up and restoring
key pairs or keysets are detailed in

>
>

Keyset backup or restore operations should not be attempted without thorough knowledge of the procedure
and the possible consequences of incorrect actions. It is strongly advised that the device administrator is
consulted prior to performing a keyset backup or restore operation.
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This section outlines the following utilities:

>

>
>
>

Administration Utility

The administration utility (gmadmin) is designed exclusively for use by the SafeNet ProtectToolkit-M device
administrator, and allows the following operations:

V V VvV VvV VvV VvV V V V V V VvV V

Initialization of HSMs

Synchronization of HSM clock with the system clock
Setting of the adapter transport mode

Setting security flags

Changing of the SafeNet ProtectToolkit-M device administrator password
Upgrade of the HSM firmware

Allocation of keyset space

De-allocation of keyset space

Creation of keysets

Deletion of keysets

Viewing the HSM event log

Purging the HSM event log

Tampering the HSM

Please note that this section is only intended as a reference for the administration utility. When performing
administrative tasks, the reader is strongly advised to refer to for details
regarding each task.
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Figure 2: Administration Utility User Interface
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Starting and Exiting the Administration Utility

To start the administration utility, select Start > Programs > SafeNet > ProtectToolkit M > gmadmin.
After an initial splash screen, the main user interface is shown.

To exit the utility, select Exit from the File menu.

User Interface

The administration utility is presented as a Graphical User Interface (GUI), which is divided into three main
areas. These are:

> The Menu Bar — shown along the top of the utility. All available utility commands can be activated via these

menus.
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The Active Adapters display pane — shows all hardware HSMs found on the host system and their

associated keysets. These are represented as a hierarchical tree view, with HSMs being the highest
member and keysets or keyset spaces shown beneath each HSM.

>
Adapter Details

Initialized

Serial Number

Battery Status

Board Revision
Firmware Revision

Cprov Revision

Transport Mode

Clock (GMT)
Clock (local)
Event Log Count

Event Log Full

System Details

Application Count

Total Session
Count

The Details pane — broken up into two sub-groups and displays the following information.

Shows whether the currently selected HSM has been initialized. Values are either TRUE or
FALSE.

The serial number of the selected HSM.

Indicates the charge of the onboard battery of the selected HSM. This may either be GOOD or
LOW. If this indicates LOW, the selected HSM may not be able to retain stored key
information in the event of a system power failure. The HSM should be returned to your nearest
SafeNet service centre for battery replacement. See

Shows the hardware revision of the currently selected HSM.

Shows the firmware revision of the currently selected HSM.

Shows the revision of SafeNet ProtectToolkit-C found on the currently selected HSM. This is a
software component which forms part of the HSM firmware. This value may need to be quoted

when contacting SafeNet support.

Shows the transport mode which is set for the currently selected HSM. This value will be either
“None”, “Single”, or “Continuous”. Refer below for details.

Shows date and time (GMT) on the currently selected HSM.
Shows the local date and time on the currently selected HSM.
Gives a total for the number of event log entries on the currently selected HSM.

Shows if the event log is full and needs purging. This value may be either “FALSE”, indicating
that there is available space in the log, or “TRUE”, indicating that the log is full.

Shows the number of applications which are currently accessing the SafeNet ProtectToolkit-M
system. This value may show as “UNAVAILABLE” which denotes that the firmware on the
selected HSM does not support application counting.

Shows the number of open sessions to the SafeNet ProtectToolkit-M system.
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Password Entry Dialog Boxes

Most actions performed within the administration utility will require entry of the device administrator password.
The device administrator password is case-sensitive and may consist of any alphanumeric characters,
between 4 and 32 characters in length.

Figure 3: Device administrator password entry dialog box

P Administrator Password - Device O

Fleaze enter the Administratar Passward far Device O

-":"-drl-"rl PaSSWDrd [4_32] Ixxxxxxxxxxxxxxxxxx

r F.eep Pazsward

Far Session Ok Cancel

Keep Password Feature
The utility can remember the device administrator password for the duration of the session. This eliminates the
need to repeatedly enter the password for multiple operations.

To enable this feature, check the box next to Keep Password For Session when entering the device
administrator password.

When this feature is enabled, take care not to leave the administration utility
unattended. To ensure that unauthorized people do not obtain management access to HSMs,
close the administration utility once you have finished with your task.

Keyboard Shortcuts

All available menu items may be activated via keyboard shortcuts. The menu bar can be selected by pressing
the [Alt] key. Commands may then be selected by pressing the first unique letter of the required command. For
example: [Alt] followed by [A] will open the Adapter menu.

There are also a number of key combination shortcuts which willimmediately activate a command:
CTRL+1I = Initialize HSM

CTRL+A = Allocate Keyset Space

CTRL+V = View Event Log

CTRL+P = Change Admin Password

CTRL+U = Upgrade Firmware

CTRL+T = Tamper HSM

CTRL+D = De-allocate Space

vV V VvV VvV VvV VvV VvV V

CTRL+K = Create Keyset
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Context Menus

Right-clicking on an item in the Active Adapters display pane will bring up a context menu showing available
commands specific to that item.

For details about these commands, please refer to the section appropriate to the menu in question.

All Adapters Menu

The All Adapters menu is only available if there is more than one HSM installed on the system. This menu
allows the device administrator to affect all installed HSMs with a single command. The following actions can be
performed via this menu:

Initialize Adapters
This option initializes all uninitialized HSMs found on the system. Only initialized HSMs can store key
information.

Synchronize Clocks
This option synchronizes all HSMs found on the system with the value of the host system clock.

Set Transport Modes

This option sets the adapter transport mode for all adapters found on the system. The adapter transport mode
allows an HSM to be removed from the host system's PCle bus without causing a tamper condition. Atamper
will remove all sensitive material from the adapter, including the adapter configuration, keys, and certificates.

The device administrator is prompted to choose one of three possible transport modes:

> None - To be applied when adapter is installed and configured. This mode will tamper the adapter if
removed from the PCle bus.

> Single - Adapter will not be tampered after its next removal from the PCle bus. Adapter will automatically
change transport mode to None the next time the adapter is reset or power is removed and restored.

> Continuous - Adapter will not be tampered by being removed from the PCle bus.

Set Security Flags
This option allows the setting of a security mode using security flags. These flags affect both the services
available to the various users of the system, as well as specific security features of the HSM. The flags may be
specified individually to set a custom security mode, but a standard security mode is recommended. When a
standard security mode is selected, the flags are assigned values automatically to meet the requirements for
that mode. For further information see ,

,and

Set Secure Configuration
This option allows secure configuration items to be set.

A secure configuration item is one that is open for reading but requires authentication for writing. Such
configuration items are stored on the HSM, protected by the password of the device administrator.

A single item is currently supported - Allow Clear Export of Private Keys. See

SafeNet ProtectToolkit 5.5 User Guide
007-013682-003 Rev. A 08 January 2020 Copyright 2009-2020 Gemalto 53



Chapter 6: Administration and User Utilities

Set Admin Passwords
This option changes the current device administrator password for all HSMs on the host system.

Upgrade Firmware
This option performs a firmware upgrade for all HSMs on the host system. The device administrator is
prompted to enter the path to the firmware update file.

Tamper All Adapters
This option causes a tamper of all HSMs found on the system. A tamper formats the secure memory of the
HSM and thereby erases all configuration and key data.

Adapter Menu

The Adapters menu is used to perform the following administrative actions on a selected HSM:

Initialize
This option initializes the selected HSM. Only initialized HSMs can store key information.

Allocate Space
This option allocates one keyset space on the selected HSM. Keyset space is required to create user keysets.

View Event Log

This option opens the event log viewer. The dialog shows event log entries in chronological order, with the
most current event showing last. The first, prev, next and last buttons can be used to navigate through the
event details, should there be more than one page of entries.

If the event log is full, it can be purged by clicking the Purge button.

I NOTE The Purge button is disabled until the event log is full.

Purge Event Log
This option purges the event log.

I NOTE This menu option is disabled until the event log is full.

Synchronize Clock
This menu option synchronizes the clock of the selected HSM with the host system clock.

Set Transport Mode

This menu option is used to set the adapter transport mode for the selected adapter. The adapter transport
mode allows an HSM to be removed from the host system's PCle bus without causing a tamper condition. A
tamper will remove all sensitive material from the adapter, including the adapter configuration, keys, and
certificates.

The device administrator is prompted to choose one of three possible transport modes:
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> None - To be applied when adapter is installed and configured. This mode will tamper the adapter if
removed from the PCle bus.

> Single - Adapter will not be tampered after its next removal from the PCle bus. Adapter will automatically
change transport mode to None the next time the adapter is reset or power is removed and restored.

> Continuous - Adapter will not be tampered by being removed from the PCle bus.

Change Admin Password
This option changes the device administrator password for the currently selected HSM.

Upgrade Firmware
This option performs a firmware upgrade for the selected HSM. The device administrator is prompted to enter
the path to the firmware update file.

Check Firmware Upgrade File
This option is used to check the validity of a firmware upgrade file. The device administrator is prompted to
enter the path to the firmware update file.

Tamper
This option causes a tamper of the selected HSM. A tamper formats the secure memory of the HSM, erasing all
configuration and key data.

Set Security Flags
This option allows the setting of a security mode using security flags. These flags affect both the services
available to the various users of the system, as well as specific security features of the HSM. The flags may be
specified individually to set a custom security mode, but a standard security mode is recommended. When a
standard security mode is selected, the flags are assigned values automatically to meet the requirements for
that mode. For further information see ,

,and

Set Secure configuration
This menu option allows the setting of security configuration items.

A secure configuration item is one that is open for reading but requires authentication for writing. Such
configuration items are stored on the HSM, protected by the password of the device administrator.

Asingle item is currently supported - Allow Clear Export of Private Keys. See

Keyset Menu

The Keyset menu is used to perform the following administrative actions on a selected keyset:

Delete
This option will delete the currently selected keyset.
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Create Keyset
This option creates a keyset within the currently selected keyset space.

Deallocate
This option removes the selected spare keyset space.

Keyset Management Utility

The keyset management utility (gmksm) is designed for the SafeNet ProtectToolkit-M user, and allows the
following operations:

Create keysets
Generate key pairs
Delete key pairs

Show key pair properties
Add key containers

Remove key containers

V V V VvV VvV VvV V

Change passwords

Please note that this section is only intended as a reference for the keyset management utility. When
performing administrative tasks, the reader is advised to refer to for details
regarding each task.
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Figure 4: Keyset Management Utility User Interface
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Starting and Exiting the Keyset Management Utility

To start the keyset management utility, select Start > Programs > SafeNet > ProtectToolkit M > gmksm.
After an initial splash screen, the main user interface is shown (see

)-

To exit the utility, select Exit from the File menu.

User Interface

The keyset management utility is presented as a Graphic User Interface (GUI), divided into two main areas.
These are:

> The Menu Bar — which is shown along the top of the utility. All available utility commands can be activated
via these menus.

> The main display pane — shows all keysets, spare keyset spaces, key containers, and key pairs. These are
represented as a hierarchical tree view, with keysets being the highest member. Key containers and key
pairs are shown beneath each keyset.

Password Entry Dialogs

Most actions performed within the keyset management utility will require entry of the keyset user password.
The keyset password is case-sensitive and may consist of any alphanumeric characters, between 4 and 32
characters in length.
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Figure 5: Keyset password entry dialog
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Keep Password Feature
The utility can remember the keyset password for the duration of the session. This eliminates the need to
repeatedly enter the password for multiple operations.

To enable this feature, check the box next to Keep Password For Session when entering the keyset
password.

When this feature is enabled, take care not to leave the utility unattended. To
ensure that unauthorized people do not obtain access to a user keyset, close the keyset
management utility once you have finished with your task.

Keyboard Shortcuts

All available menu items may be activated via keyboard shortcuts. The menu bar can be selected by pressing
the [Alt] key. Commands may then be selected by pressing the first unique letter of the required command. For
example: [Alt] followed by [K] will open the Keyset menu.

There are also a number of key combination shortcuts which willimmediately activate a command:
CTRL+A = Add Container

CTRL+R = Remove Container

CTRL+K = Create Keyset

CTRL+P = Change Password

CTRL+G = Generate Key Pair

vV V VvV VvV VvV V

CTRL+D = Delete Key Pair

Context Menus

Right-clicking on an item in the main display pane will bring up a context menu showing available commands
specific to that item.

For details about these commands, please refer to the section appropriate to the menu in question.
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Container Menu
The Container menu is used to perform the following user actions on a keyset container:

Remove
This option removes the selected key container.

This action destroys any key pairs contained within the selected container.

Generate Key Pair
This option generates a key pair within the selected container. The user is prompted for:

> Key Usage: Select "Sign" or "Exchange".
> Key Size: Valid lengths are 512, 768, 1024, 2048 or 4096 bits.

> Exportable: Checking this box allows the generated private key to be backed up to a file on the host
machine.

Key Pair Menu

The Key Pair menu is used to perform the following user actions to a selected key pair:

Delete
This option deletes the selected key pair

Properties
This option displays the properties of the selected key pair. The following attributes are shown:

> Keyset: Displays the name of the keyset where the selected key pair resides.
Container: Displays the name of the key container where the selected key pair resides.
Usage: Displays the key usage attribute of the selected key pair. This value will be “EXCHANGE” or “SIGN”.

Size: Displays the size of the selected key pair.

vV V Vv V

Private Key Held: If "TRUE", the private key for the selected key pair is present as part of the key pair. Itis
only possible to import a public key .

> Exportable: Indicates whether the selected key pair can be backed up.
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CTKMU

Key Management Utility for the SafeNet ProtectToolkit-C environment, used for SafeNet ProtectToolkit-C
token management. This includes operations required by a token’s SO, such as setting user PINs and re-
initializing tokens, as well as those operations required by the normal User, such as object management.

A number of commands can be used with the ctkmu utility to help with key creation, deletion, import, export, as
well as PIN change, token initialization and replication.

NOTE When operating in WLD/HA mode, this utility should only be utilized to view the
configuration. Any changes to the configuration should be made when operating in NORMAL
mode.

Syntax

Create key from entered components

ctkmu ¢ —t<type>—-n<name> —a<attribute> —k<num> [-s<slot>] [-z<size>] [-i<hex_string>] [-p]

Create key with components

ctkmu ¢ —t<type>—-n<name> —a<attribute> —-k<num> —g [-s<slot>] [-z<size>] [-i<hex_string>]

Create key without components

ctkmu ¢ —t<type>—n<name> —a<attribute> [-s<slot>] [-z<size>] [-i<hex_string>] [-C<curve_name>]

Delete object

ctkmu d —n<name> [-s<slot>]

Erase smart card

ctkmu e —c<slot>

Import key(s) from single—custodian smart card

ctkmu i —w<name> —c<slot> [-s<slot>]

Import key(s) from multi—-custodian smart cards

ctkmu i —c<slot> [-s<slot>]

Import key(s) from console

ctkmu i —a<attribute> —n<name> —t<type>—-w<name> —y [-s<slot>] [-i<hex_string>] [-m] [-z<size>]

Import key(s) from file

ctkmu i —w<name> <filename> [-s<slot>] [-2]
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Import domain parameters

ctkmu idp —n<name> —t<type> —a<attribute> <filename> [-s<slot>]

Import token

ctkmu it <filename> [-s<slot>]

Import from PKCS #12 file

ctkmu j —n<name> —a<attribute> <filename> [-s<slot>] [-i<hex_string>]

List objects on token(s)

[ctkmu | —s<slot> [-V] [-n<name>]

Modify attributes

ctkmu m —n<name> —a<attribute> [-s<slot>]

Initialize or change PINs

ctkmu p [-s<slot>] [-O]

Replicate token

ctkmu rt —d <slotlist> [-s <slot>]

Smart card status

ctkmu s —c<slot>

Initialize/re—initialize token

ctkmu t [-s<slot>] [-I<label>]

Export key(s) to single—custodian smart card

ctkmu x —w<name> —c<slot> [-s<slot>] [-3] [-n<name>]

Export key(s) to multi-custodian smart card

ctkmu x —c<slot> [-s<slot>] [-3] [-n<name>] [-M]

Export key(s) to file

ctkmu x —w<name> <filename> [-s<slot>] [-3] [-n<name>]

Export key(s) to console

ctkmu x —n<name>-w<name> -y [-s<slot>] [-m]
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Export key(s) to PKCS #12 file

ctkmu x [-s<slot>] —pkLabel—keyCertLabel [—certalgo] [—pkalgo]

Export token

ctkmu xt —S<serial> <filename> [-s<slot>]

Commands

Command

idp

Description

Create Key

This command is used to generate new keys on the specified token. The —a parameter is used to
specify the attributes, the —n parameter specifies the key’s label and the —t parameter the new key

type.

contains further information on key attributes. Common uses for this command are
generation of a random key, import of a split custodian key (using the —k flag), or creation of a split
custodian key (using the —g and —k flags). When importing a split custodian key, optionally, a
supported PIN pad device can be used (using the —p flag) to ensure that the key components are
entered directly to the device.

Delete Key

This command is used to delete a key on the specified token. This command will permanently
destroy the key with the label specified with the —n parameter.

Erase Smart Card

This command is used to erase a smart card in the specified slot and will leave the smart card in an
uninitialized state.

Import Key
This command is used to import keys previously exported with the export command (see below).

Import Domain Parameters

This command is used to store Domain Parameters objects onto a Token.

The —s option indicates the slot e.g. —s1 for slot 1 — default is slot 0.

The —n option indicates the label of the new object.

The —t option specifies the key type, it may be ec or dsa or dh but only ec is supported.

The —a option allows attributes to be specified. Only the ‘P’ private and ‘M’ Modifiable attributes are
allowed. The default attribute if —a option is missing is CKA_PRIVATE=false and CKA_
MODIFIABLE=false.

The <filename> option specifies a test file that contains the information required to construct the
domain parameters.
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Command Description

it Import Token
This command is used to import a token image into the specified token. The —s parameter identifies
the token that will be replaced with the imported token image, by default slot 0 is used. The
<filename> parameter specifies the token image file to import.
To complete this operation, ctkmu will prompt for the user PIN of the destination token.
When importing into an un-initialized token, ctkmu will prompt for the SO PIN of the destination
token. If the device is running in FIPS mode, ctkmu will prompt for the device administrator PIN of
the destination token.

j Import Private Key
This command is used to import a Private Key and a Certificate from a PKCS #12 file format.

| List Information

This command is used to display information on the objects stored on the token in the specified slot.
This command will list the actual keys, certificates and other objects, or, if the token is a smart card
token previously used with the key export function information on that key backup set.

m The Modify Attributes command ‘m’ is used to toggle the specified attributes. That is, change from
TRUE to FALSE and vice versa or add the attribute if it does not exist.

p The Pin command ‘p’ is used to initialize the User PIN or to change an existing PIN (either the User
or SO PIN) the command will prompt. 'Cannot change the pin for the token in slot 1 as it is not
initialized. You can use the command "ctkmu t —s 1" to initialize this token.'

If the PIN is initialized the current PIN will be prompted for before the new PIN may be specified. To
change the SO PIN, specify the —O option.

rt The replicate token command 'rt' is used to replicate a source token to one or more destination
tokens. The —s parameter identifies the source token to be replicated, by default slot 0 is used. The
—d parameter specifies one or more destination tokens to replicate the source token to.
If an error occurs replicating to a particular token, an error will be reported and that token will be
skipped. This prevents offline or faulty devices from spoiling the replication process for other
tokens.
To complete this operation, ctkmu will prompt for the user PIN of the source token.
When replicating to an uninitialized token, ctkmu will prompt for the SO PIN of the destination
token. If the device is running in FIPS mode, ctkmu will prompt for the device administrator PIN of
the destination token.

s The Smart Card status command ‘s’ is used to display information on the smart card token
currently inserted in the specified slot. Details of the keys exported to the token will be displayed.
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Command Description

t The Initialize/Reset Token command ‘t’ allows for existing tokens to be initialized or re—initialized.
If the specified token contains an initialized token the current SO PIN will be prompted for before a
new Token label may be specified and the token re—initialized. If the token is uninitialized this
command will only operate if the ‘No clear PINs’ flag is not specified for the HSM (otherwise only
the Administrator may initialize tokens with the ctconf utility). In this case the new SO PIN and
label may be specified. Once the token has been reset or initialized a new user PIN may also be
set.

X The Export Key command ‘x’ allows for keys to be exported to one or more smart cards or to a file

orto the screen.

Keys exported to the screen are wrapped with standard algorithm and are suitable for transport to

foreign systems. Keys wrapped for smart card or file backup use proprietary algorithms and can only

be restored to compliant SafeNet ProtectToolkit-based HSMs.

The main difference between the standard and proprietary methods is that the proprietary method

wraps all the attributes of the key so that when a key is restored it must contain the same attributes

as the original.

Keys wrapped for smart card backup may use one of two basic methods; keys may be exported as

split custodian in which case they will be encrypted using a randomly generated key which is then

split and distributed to a number of smart card tokens. Alternatively a key wrapping key may be

specified which will then be used to encrypt the key specified for backup. This encrypted data can

then be written to a smart card token or to afile.

Please note that if the —j parameter is used to export a private key and certificate to a PKCS#12 file

format the following considerations need to be made. Exportable private key types are: RSA, DSA,

and ECDSA.

> If the private key being exported is marked CKA_EXPORTABLE=TRUE and CKA _
EXTRACTABLE=FALSE, the toolkit will prompt for Security Officer (SO) to login to perform the
export operation.

> User performing the PKCS#12 private key export will be asked to provide two (2) passwords
(one for Payload and one for HMAC). At this stage the user must take into account which 3rd
party tools will be used to extract the PKCS#12 file. For example, Microsoft Windows requires
that the Payload and HMAC passwords be identical. OpenSSL, however, will extract Key and
Certificate exported by ctkmu using two different passwords. The user needs to decide which
password policy best suits their needs.

> The RC family of encryption algorithms (and others) are prohibited in FIPS mode. ctkmu shall
reject the command and display a warning message if they are used under this security policy.

xt The export token command 'xt' is used to export a token for later import to a specific device. The —s
<slot> parameter identifies the source token to be exported, by default slot 0 is used. The -S
parameter specifies the serial number of the intended device where token import will be later
performed. The <filename> parameter specifies the output token image file. To complete this
operation, ctkmu will prompt for the user PIN of the source token.
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Options
Option Description

—a<attributes> —attributes =<attributes>
Specifies attributes for an object / key. Valid attributes are:

CKA_PRIVATE=1
CKA_MODIFIABLE=1
CKA_SENSITIVE=1
CKA_WRAP=1
CKA_EXPORT=1
CKA_IMPORT=1
CKA_UNWRAP=1
CKA_EXTRACTABLE=1
CKA_EXPORTABLE=1

CKA _DERIVE=1
CKA_ENCRYPT=1

CKA _DECRYPT=1
CKA_SIGN=1
CKA_VERIFY=1
CKA_SIGN_LOCAL_CERT=1
CKA_USAGE_COUNT=1 (can only be used with ¢ command)

Or<womaxXc-—ss-H=27

—c<slot> —sc-slot—-nhum =<s|ot>
Specifies the Smart Card slot to export to or import from.
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Option Description

—C<curve_name> —curve—name =<|abel>
Specifies which curve to use. Valid values are:
P-192 (also known as prime192v1 and secp192r1)
P-224 (also known as secp224r1)
P-224k1 (also known as secp224k1)
P—-256 (also known as prime256v1 and secp256r1)
P-384 (also known as secp384r1)
P-521 (also known as secp521r1)
secp256k1
c2nb191v1
c2tnb191vie
brainpoolP160r1
brainpoolP160t1
brainpoolP192r1
brainpoolP192t1
brainpoolP224r1
brainpoolP224t1
brainpoolP256r1
brainpoolP256t1
brainpoolP320r1
brainpoolP320t1
brainpoolP384r1
brainpoolP384t1
brainpoolP512r1
brainpoolP512t1
> orany valid ECC Domain Parameter object label

If —tec is specified, the —C parameter must be included in the command otherwise
ctcert will exit with an error message.

V VV V V V VYV VYV YV VYV VYV VYV VYV YV VYV

—d<slotlist> —dest =<slotlist>
Specifies a comma-separated list of tokens identified by slot number. The special
value all denotes all initialized tokens with a token label identical to the source
token label and where trust has been established between the devices.

<filename> Specifies afile to be created for export or used to import a key, certificate, token, or
set of domain parameters.

-9 —gen—comp
Generate key components.
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Option Description

—h, =? —help
Display usage information.

—j —pkes12
Export to PKCS#12 format.
—pkLabel
Private Key to be exported to PKCS#12 file.
—keyCertLabel
Certificate Label to be exported to PKCS#12 file.
—pkalgo
Private Key Encryption Algorithms. This parameter is optional. The default setting

is DES3. Possible settings are: RC4_ 128, RC4 40, DES3, DES2, RC2_128,
RC2_40.

Note that if FIPS mode is ON, then none of the algorithms in the RC family are
allowed.

—certalgo

Certificate Encryption Algorithm. This parameter is optional. In FIPS mode the
default setting is DES3. If FIPS mode is OFF, the default setting is RC2_40.
Possible settings are: RC4_128, RC4 40, DES3, DES2, RC2_128, RC2_40.

—k<numb> —num-comp =<numb>
Number of key components required to be entered or number to be generated (when
—g parameter is specified).

—I<label> —Ilabel =<label>
Specify label.
-m —multi—part

Do a multi—part key entry for console import/export.

-M —NofM
Causes the N of M scheme to be used for a multiple-custodians backup. This
means that the key is split in such a way that the original key may be recovered
with the co-operation of any of the custodians with a user specified, minimum
number of custodians being required.

—n<name> —name =<name>
Name of the object to operate on.

-0 —SO-PIN
Change the Security Officer PIN. Used with the change PIN command.
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Option

—s<slot>

—S<serial>

—t<type>

-w<name>

—z<size>

Description

—pinpad
Use a supported PIN pad device for entering key components. See
for complete PIN pad instructions.

—slot—num =<slot>

Specifies the slot to operate on. Default is 0 (zero), however must be specified
when using the | command and —v option for Slot 0.

—serial =<serial>
Specifies the device serial number.

—type=<type>
The type of key to create. Options are: aes | des | des2 | des3 | rc2 | rc4 | cast | idea
| seed |rsa|dsa|ec

—verbose
Displays the attributes that ctkmu may change.

—wrap—key =<name>
Name of the key used to wrap or unwrap.

—console
Import/Export using the console.

—size=<size>
Size of the key to create/import (for AES, RC2, RC4, CAST, RSA, DSA and
generic secret).

—Cprov2
Import keys from a Cprov 2 formatted file. This is used when migrating keys from
an older Cprov 2 key format to the current format.

—PTKC3
Generate export to smart card and file using the SafeNet ProtectToolkit-C version 3
format. Used when exporting keys to be sent to older style HSMs.

NOTE If option -3 is not present in the ctkmu command line, by default
the utility will use the CKM_WRAPKEY_AES_KWP mechanism.

—-PTKC4
Generate export to smart card and file using the SafeNet ProtectToolkit-C version 4
format. Used when exporting keys to be sent to older style HSMs.

NOTE If option -4 is not present in the ctkmu command line, by default
the utility will use the CKM_WRAPKEY_AES_KWP mechanism.
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Exit Status

The ctkmu utility will return a zero(0) exit status when successful. A non-zero exit status is returned on an
error. Warnings are not treated as errors.

CREATECERT Utility

Utility for creating a self-signed certificate.

Synopsis

createcert <X509 Name>

Description

The createcert utility is used as a quick and simple method of creating a self-signed certificate for the SafeNet
ProtectToolkit-M machine.

I NOTE The user must be logged on as administrator to use this utility.

Parameters
X509 Name The X.509 Certificate name. For example, CN=<machinename>.
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Integration with Microsoft CA

This section contains the following instructive subsections for integration with Microsoft CA:
>

>
>
>

Setting Up a CA with SafeNet ProtectToolkit-M

This section explains how to configure SafeNet ProtectToolkit-M to be used with the Microsoft CA.

SafeNet ProtectToolkit-M, in conjunction with Microsoft CA, provides secure storage of keys related to signing
certificates.

Before you begin, ensure that:

> you have read and understood and

> Microsoft CA has NOT been installed prior to the SafeNet ProtectToolkit-M installation.
> the currentlogged-on user has Windows administrator privileges.

> akeyset exists for the logged-on user.

An example of how to setup the CA with SafeNet ProtectToolkit-M on Microsoft Windows 2008 R2 follows.

NOTE This example assumes a standalone configuration for a root CA. Actual values should
be chosen as required, to suit each particular installation.

To set up the CA with SafeNet ProtectToolkit-M:

1. From the Windows Control Panel, select Administrative Tools and select Server Manager from the list
of tools.

Click Add Roles.

Check the box for “Active Directory Certificate Services”, click Next, and then Next again.
Check the box for “Certification Authority” and click Next.

Select Standalone and click Next.

Select Root CA and click Next.

Select the appropriate option (new or existing private key) and click Next.

© N o o b

Select the SafeNet CSP from the list, configure your cryptiographic options as required, and click Next.
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9. Configure your CA name as required and click Next.
10.Set the validity period for the certificate generated for the CA as required and click Next.
11.Specify the locations for the certificate database and certificate database log and click Next.

12.Review the CA configuration. If any parameters are incorrect, use the links in the left pane to return to the
appropriate page to make changes. When the configuration is correct, click Install to install the CA.

Following the successful completion of the above steps, SafeNet ProtectToolkit-M is now selected as the CSP
for Microsoft CA operations. For further details regarding the Microsoft CA, please refer to your Microsoft
documentation.

Certificate Template Support for SafeNet CSPs

The current list of certificate templates in the CA do not make use of the SafeNet CSP. New templates must be
created in the Certificate Templates store and then issued from the CA templates store. For example, a web
server certificate template only supports the Microsoft DH and RSA providers.

In order to create new templates that support the SafeNet CSP, perform the following procedure. The
procedure is basically the same for any certificate that you need to issue using the SafeNet CSPs.

To create a new template that supports the SafeNet CSP:

Note that the use of the User template in this procedure is for example only. Substitute this for any other
template to meet your particular requirements.

1. Starta new MMC session and add both the Certification Authority and Certificate Template snap-ins.
2. Expand the Certificate Templates object and locate the User template.

3. Right click on the User template and select Duplicate template. This will display the new template
properties.

4. Enter a Template display name. Note that you cannot give it the same name as the template that already
exists.

5. Gotothe Request Handling tab and click on the CSP button. Either select Requests can use any CSP
available on the subject’s computer or make sure that the SafeNet RSA providers are checked.

6. Check the Issuance Requirements and Security tabs to ensure that the appropriate permissions are
correct. Click OK to complete.

7. Now go to the CA object and select Certificate Templates.
8. Right click New and select Certificate Template to Issue.
9. Locate the new template that was created in steps 1-6 and click OK. Close the MMC console session.

10.To test that the SafeNet provider is now available, open a new MMC console and choose the Certificates
snap-in. Select My User Account when prompted. The Administrator’s personal certificate store is now
available.

11.Right click on the personal object and select All Tasks, Request new certificate. The Certificate Request
Wizard displays.

12.Click Next to reveal the certificate types available, select the new certificate and check the Advanced
check box. Click Next.
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13.0n the CSP page that now displays, note that the SafeNet providers are now listed. Choose the RSA full
provider and any other appropriate settings such as Key is Exportable, etc. Complete the process by
clicking OK.

The certificate is generated and visible in the personal store.

CA Replication (Key Backup and Recovery)

Typically, to replicate a CA installation, keys may be backed up to smart cards and then restored from the
smart cards to establish the new CA installation. One smart card per keyset is required.

Atriple-DES BackupKey is used to encrypt each keyset prior to storage on a smart card. A different BackupKey
is automatically created for each keyset when the keysets are created but these keys are not visible under
normal SafeNet ProtectToolkit-M operation. A BackupKey for a keyset is derived from a combination of the
password used to secure that particular keyset and the keyset name. In the case of the MACHINE and
SYSTEM keysets, the device administrator’s password and the keyset name are used to derive the key. Thus,
to restore a keyset that was previously backed up, the same password and keyset name must be used.

To Back Up Keys for a CA Installation to Smart Cards:

1. Obtain a listing of all keysets by executing ctkmu | from a command prompt. A list of all keysets and
associated slots displays.

NOTE Decide which keysets to back up. At a minimum, the MACHINE_Keyset must be
backed up, as this is where the CA keys are stored.

2. Record the slot number for each keyset that you wish to back up.

3. Toback up the MACHINE_Keyset to smart card, type the following in a command prompt, where nis the
slot number of the MACHINE_keyset and b is the slot number representing the smart card reader. Both n
and b can be found in the listing obtained at step 1.

ctkmu x —-sn —-wBackupKey -c

4. When prompted for a user password, enter the default “password”.
5. Inserta new smart card and repeat steps 4 and 5 for the SYSTEM_Keyset if required.

6. Insertanew smart card and repeat step 4 for each of the other keysets required.

Replicating a CA Using Keys Restored from Backup Smart Cards
The following procedure takes the following key points into account:

> Onthe machine where the replica is to be created, SafeNet ProtectToolkit-M must be installed before the
Microsoft CA.

> To allow installation of a CA that utilizes the SafeNet CSP for HSM storage of keysets, both the MACHINE _
Keyset (where the CA stores keys) and a user keyset for the current user must be available. At CA
installation time if either or both of these keysets are missing, the SafeNet CSP will not display in the list of
CSPs available for selection.
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> All keyset names and associated passwords created when establishing the replica must match the originals
that are to be restored from the backup smart cards.

To Replicate a CA Using Keys Restored from Backup Smart Cards:
1. Install SafeNet ProtectToolkit-M.

2. Start the SafeNet ProtectToolkit-M administration utility. This can be done via the Windows Start menu.
Select Start > Programs > SafeNet > Protect Toolkit M > gmadmin.

AMACHINE_Keyset and a SYSTEM_Keyset will be created. Later on, the MACHINE_Keyset created here
will be replaced with the version that was backed up to smart card, containing the CA keys.

The device administrator password will be requested, or must be set if this is the first time the HSM has
been accessed.

The Administration Utility default view displays.

3. Under Active Adapters, expand All to reveal the device and the Machine and System key sets just
created on that device.

4. Highlight the device entry and select Adapter on the menu bar. Now select Allocate Space to create a
keyset space.

5. Under Active Adapters, select the spare keyset space.

6. Select Keyset on the menu bar and then choose Create Keyset. The Administration Utility will now prompt
for a keyset name to use and the password for the currently logged-on user. The default name should be
accepted.

7. If additional user keysets containing keys are to be restored from smart card, create an empty replica
keyset on the HSM for each keyset to be restored with the same name and user password as the original.
To do this, repeat steps 4 to 6 for each keyset, using the appropriate keyset name and user password each
time.

8. Obtain alisting by name of all the keysets that now exist on the HSM and their corresponding slot numbers
by executing ctkmu | from a command prompt.

9. Import a keyset from smart card to the HSM. To do this, insert the smart card containing the keyset and
execute the following command from a command prompt:

ctkmu i —-sn -wBackupKey —-cm

where nis the slot number of the keyset on the HSM discovered in step 8, and mis the smart card reader
slot number. This will also be shown in the listing obtained at step 8.

10.When prompted for a user password, enter the value for the keyset being restored. In the case of the
machine and system keysets, the default is “password”.

11.Insert a new smart card and repeat step 4-10 for each additional keyset until all have been restored.
12.Install the Microsoft CA.

13.Select the SafeNet CSP from the drop-down box during installation. If the SafeNet option is not present, this
means that the keyset for the currently logged in user does not exist. Ensure the user is the same as the
user who did the backing up of the CAinitially.

14. After selection of the SafeNet CSP, click the Use existing keys box and select the key that corresponds to
the CA key pair.
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Private Key Archiving and Recovery

When requesting a certificate using the Windows CA, users have the option to have their private key archived
by the CA. In a catastrophic system failure that results in the user losing their entire system, this feature allows
recovery of the user’s private key.

Support for this archival and recovery process is included in SafeNet ProtectToolkit-M. The following examples
demonstrate the use of this capability.

Private Key Archiving Example
Here are the tasks required to archive a private key using a Microsoft certification authority (CA).

\"

Create a key recovery agent account

Acquire the key recovery agent certificate

Configure the certification authority to allow key recovery
Create a new certificate template that allows key archiving

Acquire a user certificate that has an archived key

Prerequisites
Before doing these tasks:

> You must have a Windows Server domain controller.

> The Windows Server domain controller must also be configured as an enterprise root or subordinate CA.
> Auser keyset for the user must exist. Refer to for further information.
>

The Allow Clear Export of Private Keys flag must be set. See the section
for the procedure.

Task 1—Creating a Key Recovery Agent Account
Configure and add the Key Recovery Agent certificate template as a template that can be issued by the
enterprise CA.

To verify who can enroll the Key Recovery Agent template:

1. Log on as administrator.
2. Click Start, Run, type certtmpl.msc, and press Enter.
This opens the Certificate Templates snap-in in the Microsoft Management Console.
3. Inthe console tree, click “Certificate Templates.”
4. Inthe details pane, right-click Key Recovery Agent and click Properties.Select the Security tab.

By default, the security groups that can enroll the Key Recovery Agent certificate template are Domain
Administrators and Enterprise Administrators.

5. To allow other users or groups to enroll the Key Recovery Agent certificate template, click Add to add the
user or group and grant them Read and Enroll permissions.
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To change the default issuance behavior of the Key Recovery Agent template:

1. In Key Recovery Agent Properties, click the Issuance Requirements tab.
2. Clear the CA certificate manager approval check box and click OK.

3. Close the Microsoft Management Console.

To change the request handling to allow the Safenet CSPs:

1. Inthe Key Recovery Agent Properties, click the Request Handling tab.
2. Check the Allow Private Key to be Exported check box.

3. Click on the CSP button and click on the radio button to allow requests to use any CSP available on the
subject’s computer.

To configure the Certification Authority (CA) to issue Key Recovery Agent certificates:

1. Onthe Administrative Tools menu, click Certification Authority.

This opens the Certification Authority snap-in in the Microsoft Management Console.
2. Inthe console tree, double-click the CA, and then click Certificate Templates.
3. Right-click Certificate Templates, then click New CertificateTemplate to Issue.

4. In Enable Certificate Template, click Key Recovery Agent, and then click OK.

Task 2—Acquiring the Key Recovery Agent Certificate
In this series of steps, you will acquire a Key Recovery Agent Certificate for the purpose of recovering private
keys. Begin by creating an MMC console with the Certificates snap-in loaded.

To ensure that you are logged on as the administrator:

On the taskbar, click the Start button, and then click Run.

In Run, type mmc, and then click OK.

On the File menu, click Add/Remove Snap-in.

In Add/Remove Snap-in, click Add.

In Add Stand-alone Snap-in, click Certificates, and then click Add.
In Certificates, click My User account and then click Finish.

Click Close, and then click OK.
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To acquire a Key Recovery Agent certificate:

1. In the console tree of the newly-created MMC console, double-click Certificates - Current User.
2. Inthe console tree, right-click Personal, click All Tasks, Request New Certificate.

3. In the Certificate Request Wizard, click Next.
4

. In Certificate Types, select Key Recovery Agent and the Advanced checkbox, and then click Next.
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5. Onthe CSP page that now displays, choose the SafeNet provider for HSM key storage and any other
appropriate settings such as Key is Exportable, etc. Then click Next and Next again.

6. On the Certificate Friendly Name and Description page, in the Friendly Name field, type Key Recovery,
and then click Next.

7. In Completing the Certificate Request Wizard, click Finish.
8. Inthe console tree, double-click Personal and then click the Certificates folder.
9. Ensure that a certificate with the friendly name of Key Recovery exists.

10.Close the console without saving changes.

Task 3—Configuring the CA to allow key recovery
In this series of steps, configure the enterprise CA to use the Recovery Agent certificate acquired in Task 2.
The CA must load the public key for the Key Recovery Agent to be used for encrypting the recovery data.

To configure the Recovery Agent to be the Administrator's Key Recovery Agent certificate:

1. Ensure that you are logged on as the administrator.

L

In Administrative Tools, open Certification Authority.

This opens the Certification Authority snap-in in the Microsoft Management Console (MMC).

In the console tree, click the CA.

Right-click the CA, and then click Properties.

Inthe CA Properties, on the Recovery Agents tab, click Archive the key and then click Add.

o 9 o

In Key Recovery Agent Selection, click the certificate that is displayed, and then click OK. The key
recovery agent certificate is shown with a status of Not loaded.

7. Click OK, and when prompted to restart the CA, click Yes.

To open the Certificates console, focused on the local computer:

On the taskbar, click the Start button, and then click Run.

In Run, type mmc, and then click OK.

On the File menu, click Add/Remove Snap-in.

In Add/Remove Snap-in, click Add.

In Add Standalone Snap-in, click Certificates, and then click Add.

In Certificates Snap-in, click Computer account and then click Next.
In Select Computer, click Local Computer, and then click Finish.
Click Close, and then click OK.

© N o o~ wbdh =

To verify the installation of the Key Recovery Agent (KRA) certificate:

1. In the console tree, double-click Certificates (Local Computer), double-click KRA, and then click
Certificates.

2. In the details pane, double-click the certificate.
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3. Verify that the intended use of the certificate is Key Recovery Agent and the certificate is issued to
Administrator. This procedure ensures that the Key Recovery Agent has been successfully configured.

4. Click OK and then close the console without saving changes.

Task 4 — Creating a new certificate template that allows key archiving

In this series of steps, you define a new template that allows Key Archival and HSM key storage by using the
Certificate Templates console. This will allow hardware key storage within a HSM at the client computer and
key recovery in the domain in the event that the private key is lost or corrupted at the client computer.

To open the Certificate Templates console:

Log on as the administrator.

On the taskbar, click the Start button, and then click Run.

In Run, type mmc, and then click OK.

On the File menu, click Add/Remove Snap-in.

In Add/Remove Snap-in, click Add.

In Add Standalone Snap-in, click Certificate Templates, and then click Add.
7. Click Close, and then OK.

Aduplicate of the Users certificate template is now created and named Archive User. This is a shortcut to
creating a template with permissions that allows both Domain Administrator and Domain User certificate
enrollments. The template is then modified so that certificate enroliments made using this template will enable
both key archival and the ability to use Safenet as a CSP.
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To create a modified Archive User certificate template:

1. Inthe console tree, click Certificate Templates.
2. Inthe details pane, right-click the User template, and click Duplicate Template.

3. Inthe Properties of New Template dialog box, in the General tab, in the Template display name box,
type Archive User.

4. Inthe Request Handling tab, enable the Archive subject's encryption private key option (see the
screen shot below). This option makes it possible for a Key Recovery Agent to recover the private key from
the certificate store.
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Properties of New Template ed |

lzzuance Requirements | Superzeded Templates | E«tenzions I Security
General Request Handling | Subject Mame

Purpoze;

IV Archive subject's encryption private key

v Include symmetric algorithms allowed by the subject

[T Delete revaked on expired certificates [do nat archivel

Finimum key zize: |1|:|24 vI

v Allow private key to be exported

Do the following when the zubject iz enrolled and when the private key
azzociated with thiz certificate iz uzed;

% Enroll subject without requiring any user input

" Prompt the uzer during enrallment

Frompt the user during enmollment and reguire user input when the
private ke iz uged

To chooze which cryptographic service providers CSPs |
[C5Pz] ghould be used, click C5P=. b

0] :4 Cancel Apply

5. Click the CSPs button to enable HSM key storage using one or more SafeNet CSPs.

The dialog box allows selection of particular CSPs or all CSPs may be enabled by selecting the appropriate
radio button.

Typically, only the Safenet RSA Full Cryptographic Provider is required. The SChannel Provider is
only needed where SSL processing will be carried out.

6. After finalizing selections, click OK and OK again to apply changes and close the dialog boxes.

7. Close the console without saving changes.

Task 5—Acquiring a User certificate that has an archived key

In this series of tasks, you will configure the certification authority (CA) to issue Archive User certificates. Using
a newly created account, you will act as a user to acquire an Archive User certificate from the CA and record
the certificate's serial number for later use.

To configure CA to issue the new Archive User certificate template:

1. Ensure that you are logged on as the administrator.

2. From Administrative Tools, open Certification Authority.
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In the console tree, double-click the CA name, and then click Certificates Templates.
Right-click Certificate Templates, click New, and then click Certificate Template to Issue.
In Enable Certificate Templates, click Archive User and then click OK.

The Archive User certificate template now appears in the details pane.

Close Certification Authority.

To create a new user account:

DD

In Administrative Tools, open Active Directory Users and Computers.
Double-click the domain.

Select Users then click the Create a new user in the current container button.
Complete the following fields to create a user account:

a. First name

b. Last name

c. User logon name (e.g. JSmith@xxxx.com)

d. Password

5. Click Next, and then click Finish.

6. Double-click the new user account, select the General tab and enter the email address. e.g.

8.
9.

JSmith@xxxx.com. This is required if the option to include the email name is set in the template used to
create the user (Subject Name tab).

For the purpose of demonstration here, add the user to the Server Operators group so they are able to log
on locally to the domain controller. This would not normally be required.

a. Selectthe Member of tab.

b. Click Add, in Select Groups, type Server Operators, click Check Names, and then click OK.
c. Click OK to close Properties.

Close Active Directory Users and Computers.

Close all open windows and log off the computer.

To open the Certificates console:

1. Logon as the user.

2. Onthe taskbar, click the Start button, and then click Run.
3. In Run, type mmc, and then click OK.

4.
5
6
7

From the File menu, click Add/Remove Snap-in.

. In Add/Remove Snap-in, click Add.
. In Add Stand-alone Snap-in, click Certificates, click Add, and then click Close.
. Click OK to close the Add/Remove Snap-in dialog box.
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To use the Certificates MMC to acquire an Archive User certificate:

In the newly-created MMC console, in the console tree, double-click Certificates (Current User).
In the console tree, right-click Personal, click All Tasks, and then click Request New Certificate.
In the Certificate Request Wizard, click Next.

Under Certificate types, select Archive User and check the Advanced checkbox. Then click Next.
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On the CSP page that is now visible, choose the SafeNet provider for HSM key storage and any other
appropriate settings such as Key is Exportable, etc. Then click Next and Next again.

6. In Friendly name, type Archive User, and then click Next.
7. On Completing the Certificate Request Wizard, click Finish.

If the dialog box shown below displays, the most likely cause of the problem is that the Allow Clear Export of
Private Keys flag has not been set. See for details.

Certificate Request YWizard

8. Double-click Personal, and then click Certificates.
9. Inthe details pane, double-click the certificate with the friendly name of Archive User.
10.1n Certificate, click the Details tab.
Note that the certificate template used to generate this certificate was Archive User, then click OK.
11.Close the new console without saving changes.

12.Close all windows and log off of the computer.

Private Key Recovery Example

Here are the tasks required to recover a lost private key previously archived using a Microsoft certification
authority (CA).

> Perform key recovery

> Import the recovered private key

Task 1—Performing a Key Recovery

In this series of tasks, perform a key recovery by using Certutil.exe. For more information on Certutil, see your
Microsoft documentation.

First, ensure that the private key is recoverable by viewing the Archived Key column in the Certification
Authority console and obtain the certificate serial number required for recovery.
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To obtain the certificate serial number of the confirmed recoverable private key:

1. Log on as the administrator.
2. From Administrative Tools, open Certification Authority.
3. Inthe console tree, double-click the CA, and then click Issued Certificates.
4. From the View menu, click Add/Remove Columns.
5. In Add/Remove Columns, in Available Column, select Archived Key, and then click Add. Archived
Key should now appear in Displayed Columns.
6. Click OK and then, in the details pane, scroll to the right and confirm that the last issued certificate to the
user has a Yes value in the Archived Key column.
NOTE A certificate template must have been modified so that the Archive bit and Mark
Private Key as Exportable attributes were enabled. The private key is only recoverable if there
is data in the Archived Key column.
7. Double-click the Archive User certificate.
8. Click the Details tab
9. Write down the serial number of the certificate. (Do not include spacing between digit pairs.) This is required
for recovery.
The serial number is a 20 character, hexadecimal string. The serial number of the private key is the same
as the serial number of the certificate.
For the purposes of this walkthrough, the serial number is referred to as serialnumber.
10.Click OK.

11.Close Certification Authority.

To recover the private key into a BLOB output file using certutil.exe:

1. From a command prompt, type cd \ and then press Enter.

Ensure that you are in the c¢:\ directory.
At the command prompt, type:

Certutil -getkey serialnumber outputblob
At the command prompt, type dir outputblob

NOTE If the file outputblob does not exist, you probably typed the serial number incorrectly
for the certificate. The outputblob file is a PKCS#7 file containing the KRA certificates and the
user certificate and chain. The inner content is an encrypted PKCS#7 containing the private
key (encrypted to the KRA certificates).

To recover the original private/public key pair using Certutil.exe:

1.

From a command prompt, type:
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2

3

Certutil -recoverkey outputblob <username>.pfx

. When prompted, enter the following information:
a. Enter new password: password
b. Confirm new password: password
c. Type exit, and then press Enter.

. Close all windows and log off as the current user.

Task 2—Importing the recovered private key
Restoration of the recovered private key to the users certificate store by importing the <username>.pfx file.

To log on as the user and start the Certificates mmc:

1
2
3
4,
5
6

. Logon as the user.

. On the taskbar, click the Start button, and then click Run.

. In Run, type mmc, and then click OK.

On the File menu, click Add/Remove Snap-in.

. In Add/Remove Snap-in, click Add.

. In Add Standalone Snap-in, click Certificates, click Add, and then click Close and OK.

To delete all certificates issued by the CA to simulate a re-installed computer:
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Right-click Certificates - Current User, and then click Find Certificates.
In Find Certificates, in Contains, type the CA and then click Find Now.
On the Edit menu, click Select All.

On the File menu, click Delete.

In Certificates, click Yes.

In Root Certificate Store, click Yes.

Close Find Certificates.

To import the certificate at c:\ <username>.pfx and let the certificates be placed automatically:
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In the console tree, right-click Personal and then click All Tasks and then click Import.

In the Certificate Import Wizard, click Next.

On Files to Import, in the File name box, type ¢:\ <username>.pfx, and then click Next.
In Password, type password and then click Next.

On Certificate Store, click Automatically select the certificate store based on the type of
certificate and then click Next.

6. On Completing the Certificate Import Wizard, click Finish.

7. Ifthe Root Certificate Store dialog box appears, click Yes.

In Certificate Wizard Import, click OK.
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Two certificates were imported. The Archive User certificate for the user is located in the Personal
certificates store and the CA certificate is located in the Trusted Root Certification Authorities store.

To verify the serial number of the imported certificate:

In the console tree, double-click Personal and then click Certificates.

Double-click the certificate.

In Certificate, click the Details tab. Verify that the serial number matches the original.

DD

Close all open windows and log off.
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This section describes some of the known issues that can occur due to incorrect configuration or usage of the
SafeNet ProtectToolkit-M product. Should you encounter any difficulties not discussed in this section, please
see

Session Exists Error
This error may occur during an attempt to allocate additional keyset space or during a delete keyset operation.
Problem: Error message during keyset delete or during space allocation / de-allocation.

Cause: There are applications that have open sessions to SafeNet ProtectToolkit-M. Certain administrative
operations require exclusive use of the system as a security measure; these include keyset sensitive tasks
such as space allocation and keyset deletion.

Solution: Close or temporarily stop any applications or services that may be using SafeNet ProtectToolkit-M
such as Certificate Services, |IS etc.

To check if an application has any open sessions to SafeNet ProtectToolkit-M, check the value shown next to
Application Count in the System section of the administration utility. This will need to be “1”, and the Total
Session Count must be “0” in order for the chosen action to succeed.

If this error persists, try re-booting your machine and check for any self- or auto-starting applications which
may open sessions to SafeNet ProtectToolkit-M.

The Certification Authority service: CertSvcis one application that may be using SafeNet ProtectToolkit-M. If
after reboot, the application count is still > 1, try disabling the service, performing the Admin operation and then
re-enabling the service.

Also try the following if applicable:

> Stop the CA

> Deactivate Directory Security (II1S)

> Reboot machine

> Run the EBKRESET utility (PCle HSM only).

NOTE If the value of Application Count is shown as “UNAVAILABLE”, your HSM firmware
doesn’t support live application counting. In such a case, it is advisable to upgrade the HSM
firmware to the latest version. Please refer to

Duplicate Container or Key Instances

Itis possible that following a key restore operation, there may be more than one instance of the same container
or key within a particular keyset.
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Problem: Duplicate key or container instance showing in keyset management utility (see
).

Figure 6: Duplicate Container Error

Duplicate Container Ed |

Defaultkeys_Conkainer exists more than once,
Refer to the product documentation ko correct the problem,

.................................

Cause: This is caused by performing a key restore whilst the same keys are already in existence on the
selected keyset. SafeNet ProtectToolkit-M does not replace existing keys during a key restore. Multiple
instances of the same key will cause the keyset management utility to show the keyset as being invalid.

Solution: Close any applications that are using SafeNet ProtectToolkit-M.
There are two methods which can be employed to address this problem:

First: Itis possible to use the CTKMU utility to manually delete one of the duplicate keys or containers.

To delete a duplicate key object:

1. Ascertain the slot on which the duplicate object resides by performing the following command:
ctkmu |

2. List the contents of the slot. For example:
ctkmu | —s<slot> Answer Yes to view private <user> objects.

3. Note the name of the object which appears twice

4. Delete one of the duplicate objects. For example:
ctkmu d —s<slot> —n<object name>
The above command shows a list of objects. The only method of determining which to delete will be to look
at the date of creation.

Second: An alternative to the above is to delete the affected keyset using the administration utility.

NOTE This can only be performed by the device administrator and destroys all containers
and key pairs on the selected keyset. Following deletion of the keyset, it must be recreated,
and key containers may then be restored from a backup.

Application Error

Problem: An application which was functioning correctly prior to SafeNet ProtectToolkit-M installation is now
not working.

Cause: This may be caused by the replacement of the default “RSA SChannel” provider. During installation,
SafeNet ProtectToolkit-M changes the default provider to be the “Safenet RSA SChannel” provider. In some
cases this provider is incompatible with certain applications.
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Solution: Restore the default previous provider. To ascertain which provider was used prior to SafeNet
ProtectToolkit-M installation, open the file “uninst.ini”, found in your SafeNet ProtectToolkit-M installation
directory. The last line of the file will detail the name of the provider prior to the installation.

You must edit your registry and change the required value. Do not perform this if you are uncertain on how to
alter the Windows registry. Obtain advice from your system administrator, or alternatively uninstall the SafeNet
ProtectToolkit-M product to see if this fixes the problem.

SafeNet ProtectToolkit 5.5 User Guide
007-013682-003 Rev. A 08 January 2020 Copyright 2009-2020 Gemalto 86



CHAPTER 9:
Integration With |IS

One of the uses for the Microsoft Cryptographic APl is for Secure Socket Layer (SSL) processing. This section
explains the steps necessary to configure and use SafeNet ProtectToolkit-M in conjunction with IIS.

Prior to performing any of the following, please ensure that SafeNet ProtectToolkit-M is correctly installed and
configured. For details, please refer to and

This section contains the following instructive subsections for integration with 11S:
>

>

Creating a Certificate

In order for SafeNet ProtectToolkit-M and the HSM to be used for SSL processing, a certificate needs to be set
up that specifies the details of the SafeNet ProtectToolkit-M machine.

There are multiple methods of creating a certificate for the machine:

>

>

> . Note that self-signed certificates created by the utility are only of
use for testing purposes.

Using IIS

When using IS to install a certificate on the host machine, the following has to be performed:
> Creating a certificate request
> Sending the certificate request to be signed by a CA

> Installing the signed certificate into 11S

To create a certificate request using IIS:

1. Startthe Internet Services Manager from the Administrative Tools menu.

2. Highlight the Default Web Site entry, and right-click to open a context menu. Select Properties. The
default web site properties dialog opens. Select the Directory Security tab.

3. Click on the Server Certificate button. This will start the |IS Certificate Wizard.
4. Choose Create a new certificate from the available options and press Next to continue.

5. Choose Prepare the request now, but send it later from the available options and press Next to
continue.
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6. Select SafeNet as the security provider. On the Name and Security Settings page that now displays,
check the Select cryptographic service provider (CSP) for this certificate checkbox. Click Next to
continue.

7. Continue to follow the on-screen prompts until the certificate request is completed.

The IIS Certificate Wizard creates the certificate request as a file. You should now forward this file onto your
CAin order to have it signed. The CAreturns a new file, which is the signed certificate.

Refer to for details on how to install the signed
certificate.

Creating a Certificate Using the Microsoft CA server

The Microsoft CA server provides a standard internet browser interface for the creation of certificates.

NOTE Before starting the following procedure, ensure that the current logged on user has
Windows administrator privileges and has a valid keyset.

To create a certificate using MS CA server:

1. Start the MS CA services interface by opening your web browser and specifying the Microsoft CA server
URL. For example:

http://hostname/certsrv

The opening dialog for CA services appears.

2. Selectthe Request a certificate option and press Next to continue. You are prompted to select the
request type.

3. Choose, Advanced request and press Next to continue. You will be presented with the Advanced
Certificate Requests screen.

4. Select Submit a certificate request to this CA using a form, and press Next to continue. You will be
presented with a form to input the certificate details.

5. Enter the details for the certificate into the fields provided:

a. Certificate Name: enter the host machine's name. This can be found by executing the standard
Windows command hostname from a command prompt.

Intended Purpose: choose Server Authentication Certificate.
Key Options: choose SafeNet RSA SChannel Cryptographic Provider as the CSP
Key Usage: choose Exchange

Key Size: enter as required, eg. “1024”

"o a0 T

select Create new key set

if you want to be able to back up the keys associated with the certificate at a later date, choose Mark
keys as exportable

@

h. choose Use local machine store

i. Additional Options: choose Hash Algorithm, e.g. “MD5”
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NOTE If the currentlogged-on user’s keyset does not exist when the Safenet CSP is
selected, the Hash Algorithm list box at the bottom of the screen will be empty. Should this
be the case, abort this operation and create a keyset for the currently logged-on user before
attempting this task again.

6. Pressthe Submit button when you have confirmed your inputs. If the Microsoft CA was configured to “Auto
Issue” certificates, you are presented with the Certificate Issued dialog.

Click Install this certificate to complete the certificate request and installation.

If CA Services is not configured to auto-issue certificates, the dialog will state that your certificate request is
pending. You will have to check on the status of the certificate using the CA services at a later time. When
the certificate is ready, you are presented with the Certificate Issued dialog.

Using the createcert utility

The createcert utility is provided as a simple means to create a self-signed certificate for the SafeNet
ProtectToolkit-M host machine.

NOTE These certificates are intended for development and testing purposes only. Also
ensure that the current logged on user has Windows administrator privileges and has a valid
keyset.

You will need to know the machine name for the SafeNet ProtectToolkit-M system. Run the standard Windows
command hostname from a command prompt.

To create a self-signed certificate using createcert utility:

From a command prompt, execute the utility createcert, specifying the machine name. For example, if the
machine name is “betaone”, the command would be as follows:

C:\>createcert CN=betaone

Successful execution of the above will resultin an RSA key pair being created, as well as a certificate which is
saved in the file “selfsigned.cer”. This certificate is then automatically installed ready for 1S use.

File calles SelfSigned.cer has been saved.
Certificate created successfully and installed

Installing a Certificate for use with IS

In order to make use of the certificate in IS, it will need to be assigned to a website.

To install the certificate with IIS:

1. Startthe Internet Services Manager from the Windows Start/Programs/Administrative Tools/ menu.
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2. Highlight the “Default Web Site” entry, and right-click to open a context menu. Select Properties. The default
web site properties dialog opens. Select the Directory Security Tab.

Default Web Site Properties 7] x|

Wweb Site | Operators I Performance I |SAPI Filters I Hame Directany I Documents I
Directory Security | HTTF Headerz I Cuztom Errors I Server Estengions

— Anonymouz access ahd authentication control

authentication methods for thiz resource.

! ; Enable anonymous access and edit the

— |P addresz and domain name restrictionz

[Grant aor deny access ta this rezource wsing
IF addreszes or internet domain names.

Edit.. |

— Secure communications

Require secure communications and
enable client certificates when this

IegolUICE it accessed, . N
Wiew Certificate,..

Server Certificate. .. |

Ed. |

k. Cancel Spply | Help |
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3. Click on the Server Certificate button. This will start the II1S Certificate Wizard.

4. Depending on how the certificate was generated, the IS Certificate Wizard will prompt for the following:

If there is an outstanding certificate request:

The IS Certificate Wizard will inform the user that there is a pending certificate request.
1. When prompted, choose “Process the pending request and install the certificate”.

2. Continue to follow the on-screen prompts until the certificate is installed.

If there is no outstanding certificate request:

The 1IS Certificate Wizard will prompt the user to assign a certificate using one of three possible methods.

1. Choose “Assign an existing certificate” from the available options and press Next to continue.

I1S Certificate Wizard

Server Certificate
There are three methods for azsigning a certificate to a'wWeb site.

Select the method you want bo wze for this web site;

{~ Create a new certificate.

e izaign an emisting certificats

" Impart a certificate from a Key Manager backup file.

< Back I Mt > I Cancel

The example below shows that three certificates are currently installed.
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IS Certificate Wizard x|

Available Certificates
The certificates you can use for vour Web zerver are listed below,

Select a certificate:;

lzzued To | |zzued By | E wpiration [ ate | Intended Purpose | Frie
betaone betaone 9/11/2003 Server Authentication  <Mc
betanne RS CA 911/2002 Server Authentication <M
hSCA, S A, 917142003 <M
1] | 2

¢ Back I [ [ Canicel

The firstlisting is a self-signed certificate, created using the createcert utility. Note that the “Issued To” and
“Issued By” fields are the same. If you decide to install this type of certificate, you will receive a “Security
Alert” when trying to access the web site using Microsoft Internet Explorer. When using self-signed
certificates, you will not be able to acquire a secure connection using Netscape 6.0. For more details please
refer to

The second listing in the example is a certificate generated using Microsoft CA. Note that in this case the
“Issued To” and “Issued By’ fields reflect that this is not a self-signed certificate.

The last listing in the example dialog is the Microsoft CA certificate used to sign certificate requests. This
certificate appears in the list because the CA was set up on the same machine as the one being configured.

2. Select the certificate you wish to install and press Next to proceed with the certificate installation.

This concludes the certificate installation for IS, and SSL connections can now be made to the default web
site.
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Objects, as described by PKCS #11, consist of a number of attributes that define both the object and its access
policy. In general, the SafeNet ProtectToolkit-C system will define the object’s attributes. Access policy should
be provided by the user based on their particular requirements. The following attribute descriptions are
intended to assist with these decisions.

Attribute Description

CKA_ LABEL This attribute specifies a textual label for an object. This label is used to assist in
differentiating the various objects stored on a token.

NOTE Although SafeNet ProtectToolkit-C does not require this attribute to be
unique, various other tools may.

CKA_CLASS This attribute is assigned by the system when an object is created. There are a number of
classes in common use:

CKO_PUBLIC_KEY
CKO_PRIVATE_KEY
CKO_SECRET_KEY
CKO_CERTIFICATE
CKO_CERTIFICATE_REQUEST
CKO_DATA

V V.V V V V

CKA _KEY_TYPE This attribute specifies the key type associated with the object. There are many key types
supported by SafeNet ProtectToolkit-C. For example:

> CKK_AES, CKK_DES, CKK_DES2, CKK_DES3, CKK_RSA, CKK_DSA, CKK_
BIP32

CKA_ENCRYPT
CKA_DECRYPT
CKA_SIGN
CKA_VERIFY
CKA_WRAP

> CKA_UNWRAP

The previous attributes describe the cryptographic operations the key may be used for.
Careful consideration should be given when assigning these attributes, to avoid key
misuse.

V V.V V V

CKA_IMPORT This attribute is similar to the standard CKA_UNWRAP attribute. It is used to determine if
a given key can be used to unwrap encrypted key material. The important difference
between these attributes and their standard counterparts is that if CKA_IMPORT is set to
True and CKA_UNWRAP attribute is set to False, then the only unwrap mechanism that
can be usedis CKM_WRAPKEY_DES3 CBC. With this combination, the error code
CKR_MECHANISM_INVALID will be returned for all other mechanisms.

CKA_EXPORT This attribute is similar to the CKA_WRAP attribute, in that it specifies that the key may be
used to encrypt a second key, so that it may be extracted from the HSM in an encrypted
form. Unlike the CKA_WRAP attribute, however, only the Security Officer may specify this
attribute.

SafeNet ProtectToolkit 5.5 User Guide
007-013682-003 Rev. A 08 January 2020 Copyright 2009-2020 Gemalto 93



Attribute Description

CKA_SENSITIVE This attribute specifies that the key object cannot be extracted from the token in the clear.

Generally this attribute should be specified to ensure the key material is not exposed.
When the No Clear PINs flag is set only sensitive keys may be created on the HSM.

CKA_ These attributes are used to specify that the key may be extracted from the token in an
EXTRACTABLE/ encrypted (for example, wrapped) form. These attributes determine how the key may be
CKA EXPORTABLE backed up. Please consult the key backup section in "Unauthenticated Users" in the

B SafeNet Protect Toolkit-C Administration Guide for more information.
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CHAPTER 11:
Work Load Distribution

This chapter describes some of the benefits and limitations of using Work Load Distribution (WLD) in SafeNet
ProtectToolkit-M.

A full description of WLD can be found in the SafeNet ProtectToolkit-C Administration Guide.

Benefits of WLD

WLD allows work to be balanced across a system by transferring units of work among HSM processing
modules during execution. The demand placed on any particular processing module is thereby reduced. This
results in an increase in the overall throughput of processing tasks for the system as a whole.

Utilization of multiple HSMs under WLD also provides redundancy in that if a HSM goes down, with the
exception of the master HSM, the work will be shared amongst the remaining operational HSMs automatically.
If the master HSM goes down this will most likely cause system failure.

WLD Limitations

Read-Only

Using SafeNet ProtectToolkit-M as a CSP under WLD is severely limited. WLD does not support write/create
operations. Therefore, the CSP cannot be used to create certificates when in WLD mode, as this involves
creating a key pair. The CSP can, however, be used to sign certificate requests that have been generated by a
client, provided the client also generated their own key pair.

Admin Token Cannot Be Distributed - Single Point of Failure

The HSM's admin token contains relevant configuration information. WLD does not allow replication of admin
tokens. SafeNet ProtectToolkit-M has a 'secure configuration', a collection of configuration items stored on a
data object on the admin token, readable but not modifiable by anyone other than the administrator. The
relevant secure configuration item here is 'clear export'. This specifies whether or not keys may be exported in
the clear. Since admin tokens cannot be replicated, it is necessary to expose the admin token of one of the
HSMs in the array, called the master HSM. If the master HSM fails, the admin token will no longer be available,
most likely causing system failure.
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CHAPTER 12:
Registry Configuration

The registry entries documented here are those created by default when SafeNet ProtectToolkit-M is installed
unless otherwise noted.

This section contains the following entries:

V V VvV VvV VvV VvV Vv V

Disclaimer

The SafeNet ProtectToolkit-M registry configuration, as documented in this appendix, should only be modified
by personnel who are competent at making changes to the Windows registry using the regedit utility.
Changing the registry incorrectly can leave a system in an unrecoverable state and Gemalto cannot be held
responsible should this occur. If you are unfamiliar with editing the registry, it is strongly advised that you refer
to your Windows documentation or seek help from a qualified systems administrator before attempting any
changes.

ptkcRuntime

Key Location
HKEY_LOCAL_MACHINE\SOF TWARE\SAFENET \ProtectToolkit M\ptkcRuntime

Type
REG_SZ
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Values

The SafeNet ProtectToolkit-M product relies on the SafeNet ProtectToolkit-C product. This is a string value
which is used to record the version of the SafeNet ProtectToolkit-C runtime installed in the SafeNet
ProtectToolkit-M installation directory.

CryptokiPath

Key Location
HKEY_LOCAL_MACHINE\SOF TWARE\SAFENET\ProtectToolkit M\CryptokiPath

Type
REG_SzZ

Value

This string value is the path to where SafeNet ProtectToolkit-M is installed. This path is used to locate the
required cryptoki.dllfile.

debuglLevel

Key Location
HKEY_LOCAL_MACHINE\SOF TWARE\SAFENET\ProtectToolkit M\debugLevel

Type
REG_DWORD

Values

Valid values are 0 through 5. If turned on, debug output is saved in the ptkm.log file in the root directory of the
current drive. Each level includes the output of all preceding levels.

> 0:nodebug output
> 1:log the invocation of CSP related methods and if an error occurs, their return code

> 2:Internal errors are converted to NTE_SYS_FAIL. This debug level logs the internal error at the point of
conversion.

\"

3: CSP function input and output parameters - but NOT user related data (such as encrypted or clear text,
or data to hash).

\"

4: Other information not covered by the preceding levels - but NOT user related data.

v

5: Lists the Cryptoki function calls, by name only.

Note that the debug level is read when a process loads the SafeNet ProtectToolkit-M library file. This means
that in order to change the debug level, you must first stop any SafeNet ProtectToolkit-M applications.
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The log file ptkm.log is cleared during initialization of the SafeNet ProtectToolkit-M library.

Safenet RSA Full Cryptographic Provider

Key Location

HKEY_LOCAL_MACHINE\SOF TWARE\Microsoft\Cryptography\Defaults\Provider\Safenet RSA Full
Cryptographic Provider

Description

This is the registry key (and contained values) which defines one of the CSPs installed by the SafeNet
ProtectToolkit-M product.

Safenet RSA SChannel Cryptographic Provider

Key Location

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Cryptography\Defaults\Provider\Safenet RSA SChannel
Cryptographic Provider

Description

This is the registry key (and contained values) which defines one of the CSPs installed by the SafeNet
ProtectToolkit-M product.

Default RSA SChannel Cryptographic Provider Type

Key
HKEY_LOCAL_MACHINE\SOF TWARE\Microsoft\Cryptography\Defaults\Provider Types\Type 012

Description

This is the registry key which defines the default “RSA SChannel” provider. This provider is used by
applications which request RSA SChannel services, but do not specify which provider (such as IIS).

Value

Name of the default provider, after installing SafeNet ProtectToolkit-M. This should be “Safenet RSA SChannel
Cryptographic Provider”.
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Default RSA Full Cryptographic Provider Type

Key Location
HKEY_LOCAL_MACHINE\SOF TWARE\Microsoft\Cryptography\Defaults\Provider Types\Type 001

Description

This is the registry key which defines the default “RSA Full” provider. During the logon process, this provider is
used to validate the entered password.

NOTE The logon process requires a particular key pair to exist. This key pair does not exist
in the “SafeNet RSA Full” provider. Therefore, the default should NOT be set to “SafeNet RSA
Full Cryptographic Provider”

Value
Name of the default provider. This should NOT be “SafeNet RSA Full Cryptographic Provider”

Silent User Keyset Login Password

Key Location
HKEY_CURRENT_USER\Software\SafeNet\ProtectToolkit M

Description

This entry is NOT created by default. Create it manually if silent User keyset login is required. See
for further information.

Value
Enter the password as clear text for key entry “UserKeysetPassword”.
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APPENDIX A:
Event Log Error Types

The following table lists the error entries that may be generated by the ProtectServer HSM firmware and written
to the HSM’s event log.

Eventrecords are written sequentially and chronologically. If the date and time of a later entry in the log is
stating an earlier time than an entry preceding it, it indicates that the real time clock or audit information has
been altered.

Name Description

POST_ERR_SRAM WRITE POST Error: Cannot write to SRAM
POST_ERR_SRAM READ POST Error: Cannot read from SRAM
POST_ERR_SDRAM DATA STUCK POST Error: SDRAM, bit stuck
POST_ERR_SDRAM DATA_SHORT POST Error: SDRAM data bits short

Param 1. Bit number
Param 2. Value

POST_ERR_SDRAM ADDR_STUCK POST Error: SDRAM address bit stuck

POST_ERR_SDRAM ADDR_SHORT POST Error: SDRAM address bits short
Param 1. Bit number

POST_ERR_SDRAM BAD_BYTESEL POST Error: SDRAM bad bytes select
POST_ERR_BAD_SECTORO POST Error: POST Sector checksum is not correct
POST_ERR_NOMEM Cannot allocate memory

POST_ERR_OS_HASH The OS hash value is incorrect

POST ERR KAT Known answer test failed

Param 1. Algorithm Identifier
Param 2. Error Code

POST ERR_RNG RNG did not pass chi-squared test

POST_ERR_NO_THREAD Unable to start POST Thread
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Name

POST ERR_SMFS

POST ERR RTC

POST ERR SER

EXCEPT_ UNDEF

EXCEPT SWI

EXCEPT PREFETCH

EXCEPT DATA

EXCEPT IROQ

ERR_HOT TAMPER

LOG_FIRST ENTRY

LOG INITIALIZING SRAM

LOG_EVENT LOG PURGED

ERROR ASSERT

ERROR INIT RESOURCE

ERROR INIT PLATFORM

Description

Secure memory file system error
Param 1. Error Number

Unable to access RTC
Unable to access UART

An undefined instruction has been executed
Param 1. Address
Param 2. Instruction

A software interrupt generated
Param 1. Address
Param 2. Instruction

A Prefetch abort generated
Param 1. Address

A Data abort generated
Param 1. Address

An unhandled IRQ received
Param 1. Identifier

Hot tamper detected

Initial event entry

Initializing the SRAM after a tamper
Event log has been purged

Runtime Assertion
Param 1. File
Param 2. Line

Out of resources in initialization
Param 1. File
Param 2. Line

Failed to detect hardware platform
Param 1. File
Param 2. Line
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Name

HEAP INVALID ADDRESS

HEAP MEM FREED TWICE

PCCISES TIMEOUT

PCCISES BAD STAT

PCCISES BAD DATA

PCCISES RNG STUCK

PCCISES LNAU EXCEPTION

PCCISES FAILED RESET

PCCISES RESOURCES

CPROV_0OS UPGRADED

CPROV_OS UPGRADE FAILED

PROT NO_SMPR

PROT CIPHER ERROR

KEYGEN ERR PAIRWISE

FM OP DOWNLOAD

FM OP DISABLE

Description

Heap Invalid block address
Param 1. Heap number
Param 2. Address

Heap: Memory Freed twice
Param 1. Address

PCCISES: Timeout error on device
Param 1. Error

PCCISES: Bad device status
Param 1. Status

PCCISES: Bad input data

PCCISES: Continuous RNG test error
Param 1. Value

PCCISES: Large Number Arith Hardware exception (Unit,0)

PCCISES: Failed to reset
PCCISES: Insufficient resources to start driver

OS Upgrade performed
Param 1. Mod
Param 2. Version

OS Upgrade failed

PROTECTION: HSM SMPR not found
PROTECTION: Cipher operation failed

Key generation: Pair-wise consistency failure

FM Download Performed
Param 1. Mod
Param 2. Version

FM Disabled
Param 1. Mod
Param 2. Version
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Name

FM MODULE FAILED

PTKC_CFG_CHNG

Description

FM failed to load
Param 1. Mod
Param 2. Version

SafeNet ProtectToolkit-C config change
Param 1. New Val
Param 2. Old Val
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Glossary

A

Adapter
The printed circuit board responsible for cryptographic processingina HSM

AES
Advanced Encryption Standard

API

Application Programming Interface

ASO

Administration Security Officer

Asymmetric Cipher

An encryption algorithm that uses different keys for encryption and decryption. These ciphers are usually also known
as public-key ciphers as one of the keys is generally public and the other is private. RSA and EIGamal are two asym-
metric algorithms

B

Block Cipher

A cipher that processes input in a fixed block size greater than 8 bits. A common block size is 64 bits

Bus
One of the sets of conductors (wires, PCB tracks or connections)inan IC

C

CA
Certification Authority

CAST

Encryption algorithm developed by Carlisle Adams and Stafford Tavares
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Certificate

A binding of an identity (individual, group, etc.) to a public key which is generally signed by another identity. A cer-
tificate chain is a list of certificates that indicates a chain of trust, i.e. the second certificate has signed the first, the
third has signed the second and so on

CMOS

Complementary Metal-Oxide Semiconductor. A common data storage component

Cprov
ProtectToolkit C - SafeNet’'s PKCS #11 Cryptoki Provider

Cryptoki
Cryptographic Token Interface Standard. (aka PKCS#11)

CSA
Cryptographic Services Adapter

CSPs

Microsoft Cryptographic Service Providers

D

Decryption
The process of recovering the plaintext from the ciphertext

DES
Cryptographic algorithm named as the Data Encryption Standard

Digital Signature

A mechanism that allows a recipient or third party to verify the originator of a document and to ensure that the doc-
ument has not be altered in transit

DLL

Dynamically Linked Library. A library which is linked to application programs when they are loaded or run rather than
as the final phase of compilation

DSA
Digital Signature Algorithm

SafeNet ProtectToolkit 5.5 User Guide
007-013682-003 Rev. A 08 January 2020 Copyright 2009-2020 Gemalto 1 05



Appendix B: Glossary

E

Encryption

The process of converting the plaintext data into the ciphertext so that the content of the data is no longer obvious.
Some algorithms perform this function in such a way that there is no known mechanism, other than decryption with
the appropriate key, to recover the plaintext. With other algorithms there are known flaws which reduce the difficulty
in recovering the plaintext

F

FIPS

Federal Information Protection Standards

FM

Functionality Module. A segment of custom program code operating inside the CSA800 HSM to provide additional or
changed functionality of the hardware

FMSW
Functionality Module Dispatch Switcher

H

HA
High Availability

HIFACE

Host Interface. It is used to communicate with the host system

HSM

Hardware Security Module

IDEA
International Data Encryption Algorithm

IS

Microsoft Internet Information Services
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IP

Internet Protocol

J

JCA
Java Cryptography Architecture

JCE
Java Cryptography Extension

K

Keyset

A keyset is the definition given to an allocated memory space on the HSM. It contains the key information for a spe-
cific user

KWRAP
Key Wrapping Key

M

MAC

Message authentication code. A mechanism that allows a recipient of a message to determine if a message has been
tampered with. Broadly there are two types of MAC algorithms, one is based on symmetric encryption algorithms and
the second is based on Message Digest algorithms. This second class of MAC algorithms are known as HMAC
algorithms. A DES based MAC is defined in FIPS PUB 113, see http://www.itl.nist.gov/div897/pubs/fip113.htm. For
information on HMAC algorithms see RFC-2104 at http://www.ietf.org/rfc/rfc2104.txt

Message Digest

A condensed representation of a data stream. A message digest will convert an arbitrary data stream into a fixed size
output. This output will always be the same for the same input stream however the input cannot be reconstructed
from the digest

MSCAPI
Microsoft Cryptographic API

MSDN

Microsoft Developer Network
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P

Padding

A mechanism for extending the input data so that it is of the required size for a block cipher. The PKCS documents
contain details on the most common padding mechanisms of PKCS#1 and PKCS#5

PCI

Peripheral Component Interconnect

PEM
Privacy Enhanced Mail

PIN
Personal Identification Number

PKCS

Public Key Cryptographic Standard. A set of standards developed by RSA Laboratories for Public Key Cryptographic
processing

PKCS #11
Cryptographic Token Interface Standard developed by RSA Laboratories

PKI

Public Key Infrastructure

ProtectServer
SafeNet HSM

ProtectToolkit C

SafeNet's implementation of PKCS#11. Protecttoolkit C represents a suite of products including various PKCS#11
runtimes including software only, hardware adapter, and host security module based variants. A Remote client and
server are also available

ProtectToolkit J
SafeNet's implementation of JCE. Runs on top of ProtectToolkit C

R

RC2/RC4
Ciphers designed by RSA Data Security, Inc.
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RFC

Request for Comments, proposed specifications for various protocols and algorithms archived by the Internet Engin-
eering Task Force (IETF), see http://www.ietf.org

RNG

Random Number Generator

RSA
Cryptographic algorithm by Ron Rivest, Adi Shamir and Leonard Adelman

RTC
Real Time Clock

S

SDK

Software Development Kits Other documentation may refer to the SafeNet Cprov and Protect Toolkit J SDKs. These
SDKs have been renamed ProtectToolkit C and ProtectToolkit J respectively. @ The names Cprov and Pro-
tectToolkit C refer to the same device in the context of this or previous manuals. @ The names Protect Toolkit J and
ProtectToolkit J refer to the same device in the context of this or previous manuals.

Slot
PKCS#11 slot which is capable of holding a token

SlotPKCS#11

Slot which is capable of holding a token

SO
Security Officer

Symmetric Cipher

An encryption algorithm that uses the same key for encryption and decryption. DES, RC4 and IDEA are all sym-
metric algorithms

T

TC
Trusted Channel

TCP/IP

Transmission Control Protocol / Internet Protocol
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Token
PKCS#11 token that provides cryptographic services and access controlled secure key storage

TokenPKCS#11

Token that provides cryptographic services and access controlled secure key storage

U

URI

Universal Resource |dentifier

Vv

VA
Validation Authority

X

X.509
Digital Certificate Standard

X.509 Certificate

Section 3.3.3 of X.509v3 defines a certificate as: "user certificate; public key certificate; certificate: The public keys
of a user, together with some other information, rendered unforgeable by encipherment with the private key of the cer-
tification authority which issued it"
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